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Overview

Welcome to version 8.3 of the IDEXX Cornerstone* Practice Management System! With your help and
the input of many of the nearly 6,000 other practices in the Cornerstone family, we've included
enhancements and new features in Cornerstone 8.3 software that will improve communications within
the practice, increasing your efficiency and your ability to provide an exceptional experience for your
clients. By adding a series of new open-systems integrations, Cornerstone 8.3 will:

e Improve the data sharing between Cornerstone and your chosen lab and imaging resources.

e Simplify your ability to communicate via fax or email with referral practices or your clients and track
those communications.

e Advance your inventory management capability, ensuring accurate and efficient ordering, receipt,
and storage.

e Significantly enhance communication with your clients and ultimately improve their loyalty to your
practice.

Thank you for your help in determining what advancements to introduce in Cornerstone 8.3. And as
always, please share with us any feedback you have on continuing to enhance Cornerstone to better
meet your needs.

About This Document

This document provides information on the new features and functionality in the IDEXX Cornerstone 8.3
software. It includes key information you'll need to set up and use these new features and provides
examples of the new windows available in the Cornerstone 8.3 software.

Intended Audience

This document is for experienced users of the Cornerstone software and assumes that you have a good
working knowledge of an earlier release. If you are new to the software, you should review the reference
material and training documents available online at idexx.com/cornerstoneresources.

Note: After installing Cornerstone 8.3, a Cornerstone Administrator must adjust security settings for your
practice so that staff members can access the new features. See the Cornerstone 8.3 Getting Started
Guide for a listing of these security settings.

Documents to Help You Get Started with Cornerstone 8.3

To help ensure a smooth transition to your new IDEXX Cornerstone 8.3 software, we recommend using
the Cornerstone 8.3 Getting Started Guide in combination with the Cornerstone 8.3 What’s New Guide.
Use the sections of the two documents in the order listed on the following page.

Cornerstone 8.3 What’s New 7
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Plan

1. Review hardware/operating system guidelines.

2. Review a checklist of preinstallation tasks to prepare for

Getting Started Guide: .
1 and take advantage of the new features in this release.

Preinstallation (sections 1-3)
3. Review special requirements if you are using a DVD to

install Cornerstone.

Install and set up

2 Getting Started Guide:

Installation (sections 4-7) Follow the recommended steps for installation.

What’s New in Cornerstone 8.3:
3 Setup instructions at the beginning
of each feature section

View detailed information about setting up and using the new
features and functionality in this release.

4 Getting Started Guide: Reference this plan to set up security for new features and
Security and Setup (section 8) configure default settings.

Use new features
Getting Started Guide:
5 Communications and training
(section 9)
What’s New in Cornerstone 8.3:

6 Use instructions within each feature | View detailed information about how to use the new features.
section

Introduce the new features you choose to implement to your
practice and train staff.

To access these resources, visit the Cornerstone Resource Library online at
idexx.com/cornerstoneresources. Copies of both documents are also installed on your computer along
with Cornerstone.

Training Files

You can also use Cornerstone tutorial training files data to complete exercises that mimic everyday tasks in
your practice without jeopardizing the integrity of your real medical records. You can access the training files
from the Microsoft® Windows start menu. Select Start > Programs > Cornerstone > Training Files.
Cornerstone opens, and uses the training files database rather than the live version of the database that
contains your practice’s information.

In the training files (including the Cornerstone Assistant training files), functionality is limited for some
Cornerstone 8.3 features which ordinarily communicate with systems outside of Cornerstone:

o Pet Health Network* Pro—You can see and use Pet Health Network Pro features like the share
button and the IDEXX Message Center alerts for appointment requests; however, these actions
won't be reflected on pethealthnetworkpro.com or petly.com.

e Inventory Ordering using IDEXX SmartOrder* with MWI® Veterinary Supply—Although you can't
use IDEXX SmartOrder, you can view the windows used for working with this feature. Also, Purchase
Order 1000 in the training files shows an example of a purchase order created using IDEXX
SmartOrder.

Cornerstone 8.3 What’s New 8
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o |IDEXX Faxing Service—Although you can't send faxes from the training files with the IDEXX Faxing
Service, this feature is very close to the new email feature that is usable in the training files. Also,
completed faxes are shown on the Communications Log in the training files.

e Antech Diagnostics® Module—A training version of this module is not available in the training files.
However, training is included when you purchase the Antech module or upgrade from the previous
version of the module.

o Lifelearn® ClientEd™ Online—You can only set up and synchronize Cornerstone with LifeLearn
ClientEd Online documents from your live Cornerstone database.

¢ VetConnect* PLUS—You can view VetConnect PLUS information for the following patients:
0 Zeke—Patient ID 15329 (Feline)
0 Blake—Patient ID 3679K-1 (Canine)
o Twister—Patient ID 120Q-1 (Canine)

e Electronic signature capture for the integrated payment solution with XCharge®—In the training
files, you can view XCharge features except the ability to capture electronic signatures.

e Activation—You cannot activate or set up any of the above features from the training files, only from
your live Cornerstone database. Also, in the configuration windows for a multi-location single
database environment, the training files do not allow you to apply primary settings to a secondary
practice.

Cornerstone 8.3 What’s New 9



Client Communications

IDEXX Pet Health Network* Pro

Communications Management for Email and Fax

Next Appointment Scheduling Reminder

Additional Client Information Enhancements

Linking Documents to Diagnosis Codes

LifeLearn® ClientEd™ Online Integration with Cornerstone

Cornerstone 8.3 What’s New
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IDEXX Pet Health Network® Pro

IDEXX Pet Health Network* Pro lets you manage communication to and from your clients right inside the
IDEXX Cornerstone* Practice Management System.

The tools available when you use IDEXX Pet Health Network Pro with Cornerstone include:
e Sending automatic reminders by mail and/or email.
e Allowing clients to confirm appointments by email or text.

e Receiving requests for appointments and prescriptions from clients on the Petly* website, as well as
receiving updated client information.

e Sharing selected documents from the patient record with clients electronically.

Your clients interact with IDEXX Pet Health Network Pro through email, text messages, and the
personalized pet pages at Petly.com. Petly.com contains individual online pet pages that provide
important updates and an engaging way for pet owners to view pet health information, request
appointments, and refill prescriptions.

Setup

Activate and Set Up IDEXX Pet Health Network Pro
Before you use the new IDEXX Pet Health Network Pro features in Cornerstone 8.3, you need
to sign up for the service. Get started by contacting an IDEXX Pet Health Network Pro communications
specialist at 1-855-627-6570 or support@pethealthnetwork.com. The specialist will walk you through the
set up of IDEXX Pet Health Network Pro for your practice. The setup steps for some key features are
outlined below, and you can find more detailed guidance on each IDEXX Pet Health Network Pro screen.

Note: IDEXX Pet Health Network Pro is a subscription-based service. There is also a charge for postcard
communications. Contact IDEXX Pet Health Network Pro for subscription information.

Set Up Reminders on IDEXX Pet Health Network Pro

You can set up email and/or postcard reminders that will be sent automatically to clients a specified
number of weeks before a patient is due for an appointment. Email reminders allow clients to confirm the
appointment electronically.

To set up reminders:

1. Login to IDEXX Pet Health Network Pro, and click Communications and Medical Reminders.
2. Onthe Medical Reminders screen, fill in the information in the Schedule and Options areas.
3. If necessary, click the edit links to edit the design of postcards and email messages.
4

When you have finished setting up reminders, log out of IDEXX Pet Health Network Pro and close
your browser window.

Set Up Appointment Request and Pharmacy Request Options

When you have IDEXX Pet Health Network Pro, you can give your clients the ability to request
appointment times from their account on Petly.com. You can also give them the ability to request
prescription refills from Petly.com. Cornerstone displays these requests so that you can schedule the
appointment or refill the prescription based on the information the client sends.

Cornerstone 8.3 What’s New 11
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IDEXX Pet Health Network* Pro

To set up appointment request and pharmacy options:
1. Login to IDEXX Pet Health Network Pro, and click Petly.
2. Fillin the information in the Appointment Requests and Prescription Requests areas.

3. When you have finished completing the information, log out of IDEXX Pet Health Network Pro and
close your browser window.

Set Up Missing Client Email Alert Options
IDEXX Pet Health Network Pro uses the client email information stored in Cornerstone to send out
reminders, confirmation requests, and invitations for clients to join Petly.com. To help ensure that email
information is obtained, a new missing email alert has been added to Cornerstone and is on by default.
You can configure how this alert is displayed and whether it is displayed at all. The alert is displayed on
the Patient Clipboard and in the Client Alert window.

To set up the Missing Client Email Address alert:

1. On the menu bar, select Controls> Defaults> Practice and Workstation, and then select Alerts in
the navigation pane.

2. Make sure that Missing Client Email Address is selected.

3. Click Save to save your changes.
Use

View Incoming Client Requests and information via the IDEXX Message Center
If a client uses Pet Health Network Pro to send a request for an appointment or prescription refill or to
update client information, you can view that information from the IDEXX Message Center in Cornerstone.

To view and act upon client requests and information:

1. On the Cornerstone toolbar, click the IDEXX Message Center =l
b tt -': Lab Results Client Messages [27] Q ;I
sron == o] o] o
2. Click the Client Messages tab.
ELLIE BANKS (15330) 01:3% pm
3. Click the appropriate subtab: ABBY BABBIT (9052) 1052 2m
CALLIE DAHLBERG (2245) 10:53 am
i (128) 152 am
e Appointment Requests WALLY AHRENS (62 ot am
HARRIET AGGERHOLM (424) 10:50 am
4 Prescrlptlon RequeStS BUDDY ABTS (10413) 10:48 am
ALLABOUT THE MONEY STANFORD (15210:47 am
° C||ent U pdates BARKSALOT ADAMS (6692) 10:46 am

Each tab displays a list of messages. Messages in black are
unread. If there is more information than the message center
can display at one time, use the arrow buttons at the bottom of
the window to move forward and back through the pages. If

you want to update the list of messages, click Refresh >3
4. To open a message, right-click it and select Open.
OR tems 1-11 of 11

To act on more than one message, hold down the CTRL key
and click each message you want, then right-click and select Open.

Cornerstone 8.3 What’s New 12



IDEXX Pet Health Network* Pro

A dialog box displays each selected appointment request, prescription request, or client update.

I Appointment Request @ ™ Prescription Request (=
Client: First Last (ID #4##) - Client: First Last (ID ##%#) A&
Patient: Pet Mame (1D #) Patient: Pet Mame (ID #)

Requested Times: Reguested ltems:
1. 416/12 between 9:00am and 11:30am 1. Frontline 75-90 #, 6 pack
2. 4/18/12 between 5:00pm and 7:00pm 2. Heartguard 75-80 #, 6 pack
3. 4/23M12 between 3:00pm and 6:00pm Phone: 555-555-1212
Phone: 555-555-1212 Notes:
I'd also like to get Frontline for Boing
Notes:
Please schedule Zoey and Fluffy together.
Zoey has been scratching alot v 4
Patient Clipboard

5. If you want to copy text from the message, highlight it and press CTRL+C. To paste this text in a text
box elsewhere in Cornerstone, click inside the text box and press CTRL+V.

6. To open the Patient Clipboard so that you can schedule the appointment, enter the prescription
refill, or make updates to client information, click the Patient Clipboard link in the lower right of the
dialog box.

Additional Message Center Tips

e The IDEXX Message Center button 1= appears in red and black when new messages and/or lab
results have been added since the last time you looked at the message center.

e The number of messages in each tab and subtab appears in brackets next to the tab or subtab
name.

e Client messages are bold black when they are unread, and light gray after you have read them.
Tip: If you want to turn a read message back to its unread state, right-click it and select Mark as
unread.

e Once a message has been deleted, it is gone from Cornerstone and cannot be retrieved; however,
you can keep messages indefinitely if you choose.

Automatic Appointment Confirmations through IDEXX Pet Health Network Pro

If you set up email reminders in IDEXX Pet Health Network Pro, the reminder includes a button that the
client can use to confirm the appointment. Also, if the client visits Petly.com within a specified number of
days before the appointment, a reminder will appear, and this reminder also includes a Confirm Your
Appointment button.

When the client confirms the appointment, the confirmation is recorded on the Edit Appointment dialog
box for that appointment. Next to the confirmation date, Cornerstone shows that the appointment was
confirmed by IDEXX Pet Health Network Pro (displayed as “PHN Pro”).

Note: If you need to clear the Confirmed on text box, click Unconfirm, just as you would if you entered
the confirmation date manually.

Cornerstone 8.3 What’s New 13



I® Edit Appointment

Client 1D: |9E43 Quentin Kluver
[405) 761-3993
Patient |D: [7985 onkey
17,11 Mos.

Biower

47.00 pounds

Current:
30 days:
B0 days
90 days:

Total due:

$0.00
$0.00
$0.00
$0.00

$0.00

Clase
Uncanfirm

ENERIFEIE

[ Transfer invoice items to patient wisit list now

Date: Wednesday, May 23, 2012 10:00 am 12/31/2010  Reminder Heartworm Prever
Scheduled on: Wednesday, Map 23, 2012 34142011 Heartwarm-EC-Lyme WetTes!
Confirmed on: [05/23/207 2 By PHN Pro a/2011 Flea/Tick Preventative 1 mo +
e
Primary | <Mone> El - o L
Secondary: [=]
Staff: |C5 Comerstong
Time units; |1 41 Length: 15 minutes
Prefis: Amount: $0.00
‘ Item | Description Quantity Price ‘ Canter‘ -

m,

Share Documents with Clients

IDEXX Pet Health Network* Pro

With IDEXX Pet Health Network Pro, you can share the following documents with clients electronically:

e Medical notes (enhanced format)

o Medical notes (text only)

e Correspondence (enhanced format)

e Correspondence (text only)

You have the opportunity to add a personal message that will appear with the document on the client’s
page at Petly.com. Once a document is shared, you cannot remove it from the client's page at

Petly.com.

Note: You can also share laboratory results and client-friendly reports from IDEXX VetConnect* PLUS

within Cornerstone.

To share a document:

1. In the Cornerstone Editor, while looking at a medical note or correspondence document that is in the

Final state, click Share.

Note: Documents in a state of Tentative cannot be shared.
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I Sinclair - lack - (15316) - ANHA Anesthesia P

- Canine - B5 pounds - Heutered Male - 11 Yrs. 6 Mos. - Retriever, Golden (Fin.. = | (= ftie]

——— [Fnal =l

Poppy Sinclnir - 5041 (207) 7555555 (Callelnr) AccaptAll Pyt

Jack - e 85 pounds 1 Caning Famevor Golden 1113 6 Moa FHoussrod Malo
AAHA Anosihusin Assessmen t & Plan Fx derkenptcn
Enchigat Wall Dam: 1000072082 [=] FIMALIZED
[
Fie Eda View Insedt Forl Pamgeaph Table Odher

Foll Sze View

m[m Anesthesia Assessment and Plan *:.;/
.

ASCCATION|
Scheduled Procedure: Patient Identification: 15316

 S— Jack
| Scheduled Date/Time:

| Paflent Hisfory: Date: Gtiober 32012  Age: 11 Yrs, 6 Mos.
Sex: Meutered Male Weight: 85 pounds

Irvoice hems | Asschmants

o 1D Descripton |

‘_J_.
I

Opon FVL | Total Amoent

The IDEXX Pet Health Network Pro—Sharing dialog box appears.

» IDEXX Pet Health Network Pro 3
staffin:] | i
Message to client
Cancel
Spell Check

This document will be shared for Maggie Mae [50-1]
onta your client's personal online pet health prafile

Al future addendurns ta this docurnent will be shared

2. Enter your staff ID and the message that you want to appear with the document.
3. Click OK. The document will appear on the client’s Petly.com page within a few hours.
Seeing What You’ve Shared

When you share a document, Cornerstone displays when and by whom a document was shared in the
following locations:

e On the Medical Note window, in the Hx Description line
e On the Patient Clipboard*, on the Summary and Medical Note tabs
¢ On the Check-in Report (either by date or by type), in the history line

Note: Laboratory results and client-friendly reports that you share from IDEXX VetConnect PLUS within

Cornerstone can be viewed from the VetConnect PLUS communications log but are not viewable
elsewhere in Cornerstone.

New Features to Record Client Email Addresses

IDEXX Pet Health Network Pro uses the client email information stored in Cornerstone to send out
reminders, confirmation requests, and invitations for clients to join Petly.com. To help ensure that email
information is obtained, some changes have been made to the Client Information window:

o If the Email address text box is empty, it is highlighted.
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o [fthe client does not want to give his or her email address, select the Email declined check box.
This tumns off the highlight on the Email address text box and turns off missing email address alerts
for this client (if you have set up missing email alerts). Also, Cornerstone displays the date on which
the client declined to provide their email address (the date you check the box).

Note: For more information about setting up missing email alerts, see “Set Up Missing Client Email
Alert Options” on page 12.

I® Ciiant Informarion for Albert Tinbetts, ir =R
o,
ClientID: 5038 Albert Tibbets, Jr Chontbalance; $0.00
- Cancel
Information Frampts /Hales | Fudomais AJRIntarmetion
Status. |Acte  [=]  Classficaton PatQwner
Tite First MI Last
| Albent Titbets. Jr Sucondery Hamis
et
Pasinl coga: 54700 City EnuClaim Swajprow W =]
Smail addeess. scrubbed_4300_9038@disposiable oo Email rem e
T ]
Lacatian Fhone | Exersin | |
(primary) (800} D00-8500 |
|
[ Potemio_| Pabierd Heen Sex | Ereed |
320 Jioutgred M hair. O

Viewing IDEXX Pet Health Network Pro Activities on Reports
Information about activities related to IDEXX Pet Health Network Pro has been added to some existing
reports:
» The Patient History Report and the Check-in Report show when a document was shared, and
who shared it.

Additional IDEXX Pet Health Network Pro Features
IDEXX Pet Health Network Pro is updated independently of Cornerstone. From time to time, new
features may be available in IDEXX Pet Health Network Pro even though you have not upgraded your
Cornerstone software. Check pethealthnetworkpro.com periodically to learn about these new features.
After you have activated IDEXX Pet Health Network Pro, you can see additional information about new
features on your practice’s IDEXX Pet Health Network Pro Home page (go to
pethealthnetworkpro.com/login and sign in).
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Communications Management for Email and Fax

Overview

The new Communications Management features offered in IDEXX Cornerstone* 8.3 Practice
Management Software allow for outbound email and fax communications tied directly to a patient record
and recorded in patient history. These improved communication tools allow you to easily share patient
information, particularly when interacting with specialty, referral, and emergency facilities. When you
initiate these communications within the Cornerstone software, steps are cut out of the workflow so that
staff members can spend less time on administrative tasks and more time helping clients and patients.

Improvements include:
o The ability to fax estimates, medical notes, and correspondence documents.

e Animproved Communications window to email medical notes, correspondence documents,
and estimates directly from the Cornerstone Editor.

e The ability to link an SMTP email account to current email functionality for medical notes,
correspondence documents, and estimates.

e The ability to send an attachment to a medical note or correspondence along with the medical
note via email or fax.

P . |

Patient : Barksalot (8692) Client * Kimberly Adams Staff ¥
Communication Type and Recipients Send Cancel
Email Fax
Subject
Documents from advanced petcare for Patient: Barksalot (6692), Client: Kimberly & Include Cover Sheet
Recipients [ 4dd client Recipients. [[] addclient
Type Name Email Address Remove Name Fax Number Remove
TO: Robert E Boston(This vistt) | david-dieffenbach@idexx.co @ Robert E Boston(This visit) (207)556-8229 Q
cc Robert E Boston(This visit) | bobboston@best.com @ Tim Johnsen(Primary) (123)456-7850 6
TO! Tim Jehnson(Primary diefdavida@gmail.com @

Message
Entered message will appear in the body of the email and/or fax cover sheet
Message limited to 512 characters. a

Attachments
File Name Type View  Remove
Barksalot-5692.pdf Medical Note & (%]

Communications window

In addition, the new Communications Log allows you to track all outbound email and fax
communications and all associated details.
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ﬂ
Communications Log Clase =l
Date Sent
From: 092412012 [ To: 02282012 |[Ff] [ only failed rowes not successfully resent Clear All Filters | | Export As .csv

v v |Recipiert Destination Reason w |Patignt Staft

Date Sent ¥ Type Status Recipient Destination Reazon Recipient Type  Patient Staff
b 09/28/2012 Email Sent Susan Gabus craig-derby@idexc:. com Client Summer cs
[ 8/2012 Email Sent Jeff Little jeffrey-little@idexc.com Client Sadie Girl cs
b 0%282012  Email Sent John Jones fionesshcah@gmail. com Doctor Sadie Girl cs
P 0%i28/2012 Email Sent John Jones cah@gmail.com Doctor Sadie Girl cs
14 Sent John Jones Doctor Sadie Girl cs
3 Sent John Jones Doctor Sadie Girl  CS
[ Sent Christopher Struebing christopher-struebing@... Other Casey cs
b 0%i26/2012 Email Sent Robin Hunt robin-hunt@idexx.com Other Casey cs
b 0282012 Email Sent Susan Deliberto susan-deliberto@idexx. .. Other Casey cs
b 0926/2012  Email Sent Robert E Boston bebbosten@best.com Doctor Barksalot cs

Search results 1 to 10 of 10 M <4 p pl Results perpage {25 | v
=

Tip: These new communication options are especially useful for specialists in all disciplines who need to
manage communications and relationships with referring veterinarians (RDVMs).

Setup

Email Setup
To activate Communications Management email features in Cornerstone 8.3, you may need to perform a
one-time setup to specify your account information.

To access Login/Password Management settings:
1. Onthe menu bar, select Lists > Practice. The Practice List dialog box appears.

2. With your practice name selected, click Update (or double-click the practice). The Practice
Information dialog box appears.

3. On the Practice Information window, in the Login/Password Management area, select
Communications — Email from the Account information for drop-down list.

4. Select one of the following Email Service options you prefer to use when emailing from Cornerstone:

o My desktop email client (such as Microsoft Outlook)—Select this option if you plan to use your
existing email software.
Note: This will already be selected if you are using your existing email software. You must have
properly configured email software to use this option.

e Cornerstone Imaging SMTP email settings (web-based email, like Gmail™, Hotmail®, etc.)—
Select this option if you want to use the SMTP email set up in Imaging defaults. To view and edit
current settings, click the edit imaging SMTP settings link to open the Imaging Configuration
window and click Email to view the default settings. (For information on imaging SMTP settings,
see “Image Email Defaults” in the Cornerstone Administrator’'s Guide.)
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Fax Setup
To activate IDEXX Faxing Service, you must be an administrator or be provided administrative rights and
complete the activation setup process below. For more information on the IDEXX Faxing Service,
contact Cornerstone Support at 1-800-695-2877.

To access Login/Password Management settings:

1.
2.

On the menu bar, select Lists > Practice. The Practice List dialog box appears.

With your practice name selected, click Update (or double-click the practice). The Practice
Information dialog box appears.

On the Practice Information window, in the Login/Password Management area, select
Communications — Fax from the Account information for drop-down list.

Select the Use IDEXX Faxing Service check box. A pop-up box displays the terms and conditions
of use.

Review the terms and click Accept to activate the service.

Upon successful activation, the system will log the user who enrolled the IDEXX Faxing Service. In
the Practice Information window, the name, time/date stamp, and a link to the IDEXX Faxing terms
and conditions are displayed. Note that all practices in a Multi-Location Single Database
configuration must accept the terms and conditions.

Note: There is an initial setup fee of $29.95 associated with this service, as well as a use fee of $0.10 per
page that IDEXX invoices monthly.

To terminate IDEXX Faxing Services:

1.
2.

4.
5.

On the menu bar, select Lists > Practice. The Practice List dialog box appears.

With your practice name selected, click Update (or double-click the practice). The Practice
Information dialog box appears.

On the Practice Information window, in the Login/Password Management area, select
Communications — Fax from the Account information for drop-down list.

Clear the Use IDEXX Faxing Service check box.

Click OK when you are prompted to confirm your intent to terminate the service.

To reactivate IDEXX Faxing Services:

>

If you have previously activated and then terminated the IDEXX Faxing Service, follow the
instructions for initial activation and enroliment, select the Use IDEXX Faxing Service check box,
and follow the same steps involved in the initial activation.

Note: You must agree to the terms and conditions again and will be subject to the activation setup fees
agreed to in the terms and conditions.

Setting Check-In Report Print Options for Communications

To set Check-in Report print options for Communications:

1.
2.

On the menu bar, select Controls > Defaults > Practice and Workstation.

In the navigation pane on the left, click Check-in and then click Check-in Print Options.
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3. If you want Communications (email/fax) information to print on the Check-in Report, select the
Communications check box and then specify the range of information to print (All, Last month, Last

3 months, etc.).
4. When you are finished, click OK.

Use

Emailing or Faxing Documents from the Cornerstone Editor

You can send a medical note, correspondence document, or estimate to a client and/or referral
veterinarian (RDVM) by email and/or fax directly from the Cornerstone Editor. The Send Document
window reflects communication preferences for any recipients set up in Cornerstone. When emailing a
medical note, correspondence document, or estimate from the Cornerstone Editor, a PDF of the
document is automatically created and attached to the email.

Note: The method used to email from Cornerstone depends on the Email Service setting selected in
Practice Information for the currently logged in practice.

To send a document from the Cornerstone Editor:
1. With the document open in the Cornerstone Editor, click Email/Fax or select File > Send
Document. The Communications window appears.
Note: Communication preferences set up in Cornerstone for clients and RDVMs are reflected on this

window.

Communication Type and Recipients
[¥] Emiail
Subject

Documents from advanced petcare for Patient: Barksalot (6692), Client: Kimberly A

Recipients [ Add client
Type Name Email Address Remove
TO Robert E Boston(This visit) | david-dieffenbach@idexx.co ﬁ
cc Robert E Boston(This visit) | bobboston@best.com 63
TO Tim Johnson(Primary) die fdavida@gmail com (%]
Message
Entered message will appear in the body of the email and/or fax cover sheet
Message limted to 512 characters.
Attachments
File Name Type View | Remove
Barksalol-6692.pdf Medical Note = [%]

Patient - Barksalot (8592) Client : Kimberly Adams

[7] Fax

Include Cover Sheet
Recipients

Name
Robert E Boston(This visit)

Tim Johnson{Primary}

Staff

Fax Number
(207)556-3229
(123)456-7890

Send Cancel

[] Add Client

Remove
(%]
(%]

Example: If Dr. Smith is listed as an RDVM for this patient in Patient Information and Dr. Smith’s
communication preference of receiving information via email has been set up in Cornerstone, the
Email check box is automatically selected and the associated email address displays in the email
Recipients list. If an RDVM is marked as the Primary for this patient, the To: email type is selected
(unless the This visit check box on the Referrals tab on the Patient Information window is cleared).
If another RDVM is marked as This visit for the patient, the CC: email type is selected. If the RDVM
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does not have communication preferences set up in Cornerstone, they will not automatically appear
in the list even if they are the primary RDVM or if the This visit check box is selected on the
Referrals tab of the Patient Information window.

2. In the Staff field, type the ID, press F2, or select the staff member from drop-down list. (Defaults to
last staff used on the workstation.)

3. If you want to send the document in PDF format by email, select the Email check box and do the
following in the Communication Type and Recipients area:

a. Inthe Subject text box, use the default subject line that displays or type in the text box to edit
the subject line.

b. If the client associated with this document has an email address set up in Client Information,
you can quickly add the client to the email Recipients list by selecting the Add client check
box. Cornerstone automatically lists the associated name and email address for the client.

c. Inthe email Recipients list, double-click in the Type field and select one of the following for
each recipient:

e To: Select this email type for all primary recipients of the message. At least one recipient
must be designated as a To recipient.

e CC: CCis an abbreviation for “carbon copy.” If you select the CC type for a recipient, a
copy of the message is sent to that recipient. All other recipients of that message can see
that the person you designated as a CC recipient has received a copy of the message.

e BCC: BCC is an abbreviation for "blind carbon copy." If you select the BCC type for a
recipient, a copy of the message is sent to the recipient, but the recipient's name is not
visible to the other recipients of the message (including other BCC recipients).

d. If you want to email the document to a recipient not currently set up with an email address in
Cornerstone, in the next available blank row in the Recipients list, complete the Name and
Email Address fields. You can change the email type by selecting To:, CC:, or BCC: from the
Type drop-down list.

e. Toremove a listed recipient, in the email Recipients list, click the Remove icon in the
applicable row.

4. IDEXX Faxing Service only: If you want to send the document by fax, select the Fax check box and
do the following in the Communication Type and Recipients area:

a. Ifyou want to include a fax cover sheet with the document, select the Include Cover Sheet
check box. Any text entered in the Message text box is included on the cover sheet.
Note: If you use a logo on your printed invoice, that logo is also applied to your fax cover sheet.

b. If you want to fax the document to a recipient not currently set up with a fax number in
Cornerstone, in the next available blank row in the Recipients list, complete the Name and Fax
Number fields.

c. Toremove a listed recipient, in the fax Recipients list, click the Remove icon in the applicable
row.

5. You can enter text in the Message text box. This text will be included in the body of the email or the
fax cover sheet.

6. The Attachments list automatically includes the document being sent in this email or fax
transmission, as well as any files that are attached to the document. These appear on the
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Attachments tab. Most common file types are supported, including PDF, CSV, GIF, JPG, JPEG, XLS,
DOC, TIF, TIFF, etc.

Note: In the Attachments list, for both a medical note (the document currently open in the
Cornerstone Editor) and correspondence documents, the Type is listed as Medical Note
Attachment.

To work with attachments, do any of the following:
e Toview an attachment in a separate preview window, click the View icon in the applicable row.

e Toremove an attachment so it is not included with the email or fax, click the Remove icon in the
applicable row.

7. Click Send to send the document and any selected attachments to the specified recipients.

Viewing Communications in the Patient Clipboard
When you send email or fax communications from Cornerstone, a line for each communication type is

generated in patient history and is viewable from the Patient Clipboard Summary and Text tabs. Email
and fax communications also display on the Summary and Text tabs in the Patient File window.

Note: If you do not want email and fax communication lines to display in patient history or on the
Summary or Text tabs, right-click a column heading, select Filter, and deselect the Communications

option.
Preview Pane Display

With a communication line selected on the Patient Clipboard Summary tab or Text tab, click Preview to
view Recipients, Attachments, Subject, and Message information in the preview pane.

Viewing the Communications Log

All email and fax communications sent from Cornerstone are tracked in a Communications Log, which
provides comprehensive details on the date sent, transaction status (sent/failed), recipient, destination
(email address or fax number), patient, and so on.

The Communications Log window allows you to:

e View all outbound email and fax communications initiated from Cornerstone during a specified date
range.

e View the communication type (email or fax), client/patient, staff associated with the communication,
the subject, and the date the email or fax was sent.

o View all recipients of the communication and the status of the email or fax transmission.

¢ Resend a failed transmission.

o View the file name, type, and a preview for all attachments included in the email or fax.

e Show only communications related to a specific communication by clicking Show Related Rows.

¢ Mobile Computing module users can view the communication history type (communication) in the
Patient Clipboard Summary tab.

You can also:

e Change the way the log is sorted by clicking on a column header; an arrow marks the column and
indicates the sort order (ascending or descending).
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e Select the Only failed rows not successfully resent check box to display only failed emails and
faxes that have not been successfully resent.

e Export the information shown in the log to a CSV file that can be opened in another software
program.

Note: Laboratory results and client-friendly reports that are emailed from IDEXX VetConnect* PLUS
within Cornerstone can be viewed from the VetConnect PLUS communications log but are not viewable
elsewhere in Cornerstone.

Accessing the Communications Log
e To view all practice communications, on the menu bar, select Activities > Communications Log.

e To view all communications for a specific patient, click the view communication log link in the
Patient Information area on the Patient Clipboard.

e To view a specific communication and all communications related to it, double-click the
communication line in the Summary or Text tab on the Patient Clipboard or click the
Communication = button.
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Next Appointment Scheduling Reminder

A new reminder has been added to help make sure that clients schedule their next preventive care
appointment before they leave your practice.

You can set up the feature to display all reminders; however, many practices prefer to have Cornerstone
display reminders only for certain invoice items.

Setup
To set up the next appointment scheduling reminder:

1. On the menu bar, select Controls> Defaults> Practice and Workstation Defaults, and then
select Appointment Scheduler in the navigation pane on the left.

2. Inthe Next Appointment Reminder Messages area, the Display next appointment reminder
messages check box is selected by default. If you don’t want appointment reminders to appear,
clear this check box.

3. To display messages only for certain invoice items:
a. Select the Only display messages for invoice items in the list below check box.

b. Tofillin the list with the invoice items for which you want a reminder, enter the invoice item ID in
an empty Item ID box or select an empty box and press F2 to select from a list.

4. When you finish, click OK.

Use

When you post an invoice, Cornerstone displays the next appointment reminder for each patient who is
on the invoice. If there’s more than one reminder for a patient, Cornerstone displays the earliest one. If a
reminder is overdue, it will still appear.

= Next Appointment Reminder

Ginger is due for Heartworm test (antigen) on 8/2/2003 ~

Sophie it due far Discount Hip R adioaraphs on 6/7/2012

Gilligan iz due for bord on 6/27/2012 v
Schedule appointrment now? [ Yes | I No J

These reminders include letter reminders that you can currently view in Cornerstone. If you set up the
feature to only display reminders for certain invoice items, Cornerstone will display only those reminders.

If you schedule an appointment using the reminder, that appointment will be printed on the invoice.

Note: The Next Appointment Reminder dialog box displays reminders for all of the patients on the
invoice, but the automatic scheduling feature takes you to the schedule for only the first patient listed.

To schedule an appointment using the reminder:

1. On the Next Appointment Reminder dialog box, select Yes. The Appointment Scheduler window
appears and displays the schedule for the date the reminder is due. If the reminder is overdue, the
schedule displays tomorrow’s schedule.
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2. Right-click the time you want and select Schedule to begin scheduling the appointment. The
Schedule Appointment for the Following dialog box appears.

3. Click Yes. The New Appointment window opens.

4. Fillin appointment information, and click OK.
Note: Be sure to check the Reminders list, since the patient may have reminders for several
services that are due the same day.
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Additional Client Information Enhancements

Setup

Set Up Missing Client Email Alert Options

To help ensure that email information is obtained, a new missing email alert has been added to
Cornerstone.

You can configure how this alert is displayed and whether it is displayed at all; it is on by default. The
alert is displayed on the Patient Clipboard and in the Client Alert window. This alert is on by default.

To set up the Missing Client Email Address alert:

1. On the menu bar, select Controls> Defaults> Practice and Workstation, and then select Alerts in
the navigation pane.

2. Make sure that Missing Client Email Address is selected.

3. Click Save to save your changes.
Use

New Features to Help Record Client Email Addresses
IDEXX Pet Health Network Pro uses the client email information stored in Cornerstone to send out
reminders, confirmation requests, and invitations for clients to join Petly.com. To help ensure that email
information is obtained, some changes have been made to the Client Information window:

o If the Email Address text box is empty, it is highlighted.

e If the client does not want to give his or her email address, select the Email declined check box.
This turns off the highlight on the Email Address text box and turns off missing email address alerts,
if you have set them up. Also, Cornerstone displays the date on which the client declined to provide
their email address (the date you check the box).

I® Client Information for Richard Aaron =N
oK
Client ID: 29251 Richard Aaron Client balance: - $0.00 -
Information | Prompts/Mates Refenals | £/F Information
Status |Active  [w|  Classification: |Pet Dwrer =]
Title First Ml Last
addess: |B470 BelsFery Rd
Postal code: (30189 City: MWoodstock State/prov: GA [+
Email &dcress: [] Emil declined [] Email Reminders
[ Texting declined
Location | Phane Eslension | Primary [ TedTo | # o
home (770] 926-6382 e B & K]
cell (678) 2383510 o} & A -
Patient D Patient Nare [ Sex Breed [ |
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Appointment confirmations shows staff who entered confirmation
On the Edit Appointment dialog box, when you enter a date in the Confirmed on text box, your staff ID is
displayed after the date.

If you click Unconfirm to clear the Confirmed on text box, your staff ID is removed as well as the
confirmation date.

Note: If you are using IDEXX Pet Health Network Pro and a client confirms an appointment on their
Petly.com page, “By PHN Pro” is displayed in place of a staff ID. See “Automatic Appointment
Confirmations through IDEXX Pet Health Network Pro,” on page 13 for more details.

a New Appointment

r— Patient inf i A inf i
Client |D: I9033 Albert Tibbetts, Jr Current: $0.00
[888) 885-8885 gg :ays. :ggg
Patient |D: I‘I 5329 Zeke ays
90 days: $0.00
10%rs. 2 Mos. —_— Unconfirm |
Sharthair, Domestic Neutered Male Total due: $0.00
Appointment — Staff time 1 — R d

Date: Thursday, October 11, 2012 5:50 amm 1

rﬂ Ll = s
Confirmed on: [10/11/2012 By: CS
coo [T = =] | | LI

Secondary: | | ~Motes

Staff: |C5 Casey Stane, DV
Time units: [1 il‘ Length: 10 minutes

Prefis: Amount: I $0.00

r intment items

Iterm I Description I Cluantiby Price |Centerlj
=

L

r

w

F)

| -

[~ Transfer invoice items to patient visit list now
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Linking Documents to Diagnosis Codes

Similar to the option of printing a document upon checking in or checking out a patient based on the
reason for the visit, you can now link one or more documents to a diagnosis code so that the document
automatically prints when the diagnosis is entered in a medical note. This option is especially useful for

linking a specific client handout document to a particular diagnosis so that the handout prints
automatically and is ready to discuss and pass on to the client.

Tip: If you have purchased and set up LifeLearn® ClientEd Online™ documents for use with
Cornerstone, these diagnosis-specific client handout documents can be linked to diagnosis codes.

Setup

Linking Documents to Diagnosis Codes

You can link documents to a specific diagnostic code in the Diagnostic Code Setup window.

To link documents to diagnostic codes:

1. On the menu bar, select Lists > Diagnostic Codes.

2. On the Diagnostic Codes dialog box, select the applicable diagnostic code and click Update. The
Diagnostic Code Setup dialog box appears.

Hospital desc: |Otitis Extemna
Default status: | Tentative

Statuz | Active [+]

Patient Advisor settings
Spstern |Ears
Subspstern: | Otitis Externa
Enabled
Linked
[] Send reminders

Exam
Meszage:

Documents

Doc ID| Description

257 Administering Ear Drops.doc

I Diagnostic Code Setup
Diagnostic code information
ak
Diagnostic code: 2305 -
WP descriptior:  Otitis Externa

3. Inthe Documents area, in the next available Doc ID field, double-click or press F2 to search for and

select a document template from the Document Template List.

4. Repeat step 3 as needed to select all applicable documents to be linked to this diagnostic code.

5. Click OK.
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Use

Automatically Printing a Linked “Diagnosis Document” from a Medical Note
The Diagnosis Document dialog box appears if you add a diagnosis to a patient record, either from the
Patient Clipboard or through a medical note or correspondence,
and you insert a diagnosis code that has been preconfigured to

Allergy - Flea Allergy Dermatitis in Dogs

link to a particular document in Cornerstone. e o e A

The problem s that | have

If you click Yes to print the linked diagnosis document, the Staff
Selection dialog box appears.

After you enter the staff ID, one of the following will happen:

e If the linked diagnosis document is a medical note or
correspondence document:

e [fthe document is a print-only document with no entries
to fill out, the document prints automatically on the
default printer.

e Otherwise, Cornerstone opens the document so that
you can print it.

e If the linked diagnosis document is a LifeLearn® client handout, the document opens in Microsoft®
Word. You can then print the document directly from Microsoft Word. (See the “LifeLearn® ClientEd
Online™ Integration with Cornerstone” section that follows for more information on LifeLearn
documents.)
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With earlier versions of Cornerstone software, LifeLearn® client education handouts could be purchased
on CD and integrated with Cornerstone through a one-time document import process. In Cornerstone
8.3, through a subscription to the LifeLearn ClientEd Online™ web-based portal, Cornerstone users can
experience the added flexibility and convenience of having continually updated articles that can be
customized and edited as often as you like, with new articles added regularly.

LifeLearn ClientEd Online allows you to:

e Access an extensive library of over 1,200 fully searchable, illustrated, educational titles that you can
email, print, or save.

e Add or replace content within any article with an easy-to-use content management system (CMS).
e Add your own articles to your custom library.

e Personalize articles to your specific patients.

e Reinforce your online presence and turn your website into a knowledge center.

¢ In Cornerstone, link content directly to diagnostic and treatment codes for automatic printing and
storage in your patient’s medical records. See “Linking Documents to Diagnosis Codes” on page 28
for more information.

After activating the ClientEd Online service through LifeLearn and performing an initial document
synchronization, ClientEd Online documents are available for selection within the Cornerstone 8.3
software.

For more information on LifeLearn ClientEd Online, visit
lifelearn-cliented.com/about_cliented or contact your IDEXX Cornerstone Sales Representative at
1-800-283-8386.

Note: Using LifeLearn ClientEd Online documents requires Microsoft® Word 2003 or newer.

Setup

Getting Started with LifeLearn ClientEd Online

Both new and existing LifeLearn customers must subscribe to the ClientEd Online service. Please
contact your IDEXX Cornerstone Inside Representative at 1-800-283-8386 for more information.

Once you have completed the sign-up process and received your LifeLearn username and password,
you can then perform the synchronization in Cornerstone to begin printing your ClientEd Online client
handout documents.

Notes:
e If you currently use CD-based LifeLearn documents with Cornerstone, rest assured that any existing

documents you may have customized or edited will not be overwritten during the sync process in
Cornerstone.

o To avoid duplicate templates in the template list, delete any CD-based LifeLearn documents
that you no longer want to use. From the toolbar, select Lists > Documents to review and
delete templates before you synchronize.
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o Ifyou had special actions set up with CD-based LifeLearn documents (for example, to
automatically print), change the special actions to link them to the online documents.

e There is a one-time user license fee associated with ClientEd Online, as well as a monthly
subscription fee.

Synchronizing LifeLearn ClientEd Online Documents with Cornerstone 8.3

Upon activation of the ClientEd Online service with LifeLearn, in Cornerstone select Tools >
Synchronize LifeLearn Documents.

 Lifelearn ClientEd Sync (=[]

File Help

nt:| Scheduls | Log

Lifelearn Account Information

Username:

Pazzword:

Local Repositary

Path; | C\CstoneSharelLifelearn

File Format: | DOC v

Header: @ Header provided by Lifelearn ClientEd Cnline

O Header provided by practice management software

Last Sync:  Mow 020411 1346 Last Complete Sync: Mow 02011 1346

] [ Sync Mowy

Status

On the LifeLearn ClientEd Sync dialog box’s Account tab, enter your LifeLearn account username and
password in the fields provided. Leave all other fields at their default settings, and click Sync Now to
update Cornerstone with the latest documents available. Once the first synchronization is run, you can
then return to this dialog box at any time to sync and receive any new documents or edits in your online
library.

Note: Depending on the speed of your Internet connection and transfer rate, the synchronization
process may take a long time the first time you sync all documents with Cormerstone. Consider doing
your initial sync during a time that you do not need to use that server, as it will be dedicated to the sync
process.

Use

Customizing and Editing Your Library of ClientEd Online Documents

LifeLearn ClientEd Online provides you with the added flexibility to edit the handouts and to ensure
consistency of the handouts across your practice. You can:

o Edit the handouts as often as you like.
e (Customize any document to reflect your practice’s philosophy, style, or culture.

e Add your own articles to your library.
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e Access a record of the edits made, date of the edit, and who in your practice has made the edits.

Any edits made in your online library will be retained and reflected the next time you sync your LifeLearn
ClientEd Online documents in Cornerstone.

Note: You will receive detailed instructions on editing and customizing your library of documents when
you sign up for the ClientEd Online service with LifeLearn. If you have questions about editing and
customizing LifeLearn documents, contact LifeLearn Customer Support at 1-800-375-7994 option 2.

Selecting a LifeLearn Document from the Start New Document Window
Using the enhanced Start New Document window in Cornerstone 8.3, you can search for a LifeLearn
document by keyword, species, topic, and/or system.

Note: LifeLearn documents do not display in the Preview pane like other document templates because
LifeLearn documents are Microsoft® Word documents.

I Start New Document g@
(%) New client-patient document
Cliert ID: Kimberly &dams Patient |D: Cazey Staff 1D: | CS Carrin Schulze, DM
() Merge from file
Find T emplate
Title ar I Category:  LifeLearn d Medical Mate
|:| Search for word Favorites: | All Templates » Medical Mote text only
Lifelearn Search — Correspandence
Keyword: Topic: | =Al Topics= [+ ] Correspondence text only
Species: <&l Species= [v]  System: [<al Systemss [v] Print Qniy
Title | Category | Type | ID__ [l |
Administering a pill. doc - M5 "wWord LL Feline Frint Only BE9 L
Administering drugs by injection.doc - M5 Word LL Feline Frint Only 570
Administering Ear Drops to your cat. doc - M5 Waord LL Feline Print Only 57
Adriiristering Eve Drops to wour Cat.doc - M5 ward LL Feline Pririt Orly BT
Adminigtering liquid medication to a cat. doc - M5 Word LL Feline Frint Only RT3
v

Select the desired document and click OK to open the document in Microsoft Word with predefined
practice and patient demographics included in the appropriate fields within the document.

Note: Microsoft Word is required to print LifeLearn documents that include your Cornerstone practice
information and patient demographics.

Other Ways to Use LifeLearn ClientEd Documents with Cornerstone

In addition to accessing LifeLearn documents on the Start New Document window, these documents
can also be linked to certain actions in Cornerstone to streamline your client communications and
automatically print client handouts.

In Cornerstone, you can link documents to:
e Aninvoice item, using the Print Document special action.
e Areason for visit.

e Adiagnosis code (see “Linking Documents to Diagnosis Codes” on page 28 for more information).
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Note: Mobile Computing module users in the field will not be able to sync LifeLearn documents but will
be able to search for them.
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Laboratory

VetConnect* PLUS
IDEXX VetLab* Station
Antech Diagnostics® Module

Miscellaneous Laboratory Enhancements
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VetConnect* PLUS

Overview
Version 8.3 of the IDEXX Cornerstone* Practice Management System, excluding the Mobile Computing
module, includes optional access to VetConnect* PLUS, a powerful web-based tool that lets you view
and compare IDEXX in-house diagnostics and IDEXX Reference Laboratories data side by side.

VetConnect PLUS works within the standard Cornerstone workflow for viewing results and has an
enhanced format for viewing, comparing, and graphing result data. You can also visit
vetconnectplus.com to view your results in a browser.

Here’s an example of a VetConnect PLUS tab.

wDetailed Lab Result Set = =10] =|
ok |
VelConnect PLUS Lab Results | DEO; Lab Reocn | Lab Resus |
JAK| SABINE
~' Trending
- rhr'\’ 11132011 (Crder Recsived) TDEXX Refsrence Laboratories ] ‘& 5/B/11 ‘& i1l
= 11/13/2011 @ 7:80 am (Last Updatsd) Shew Details
REC 6.23 5.5 - B.E M/pL [ | B.91 8.22
Hematocrit 42.8 ] | | 47.8 55.1
Hemoglobin 15.4 12 - 18 gidL ] 17.0 19.2
MLV 63 [ 77 L 1
MCH 24.7 9.5 - 26.0 pg ]
MCHC 36.0 32 - 36 g/dl |
WEC 8.6 5.7 - 16,3 K/l 1
%% Neutrophil &0 61-77 % 1 I B4 53
% Lymphocyte 28 12- 30 % | 26 35
% Monocyte 5 3-10 % 1
%% Eosinophil 0 2 - 10 | - 5 ]
1’ e B kbl - a_sm e | m n I _”ﬂ

Using VetConnect PLUS, you can:

o View the latest IDEXX test results in an enhanced and interactive window as soon as they are sent
from the IDEXX Reference Laboratories or from your in-house analyzers.

e See the complete history of a patient’s known IDEXX test results.

o Compare results from IDEXX Reference Laboratories and IDEXX VetLab* Station tests side by side.
(To do so, you must activate VetConnect PLUS on IDEXX VetLab Station.)

e Graph and view trends for IDEXX test results with the click of a button.

Cornerstone 8.3 What’s New 35



VetConnect* PLUS

Data Storage in VetConnect PLUS
VetConnect PLUS uses patient and test data stored on secure Vet Connect PLUS servers (that is, in “the
cloud”). If you choose to activate VetConnect PLUS, IDEXX will ask permission to upload a copy of
historical data from IDEXX Reference Laboratories from your VetConnect account and/or IDEXX VetLab
Station. IDEXX will not upload this information without your consent. No information is uploaded from
Cornerstone; Cornerstone performance is not affected.

Your data in VetConnect PLUS is secure:

Sensitive data is not stored in VetConnect PLUS. VetConnect PLUS stores and displays only the
following:

e Patient demographics (name, ID, age, sex, species, breed)
e Client names and IDs

e Patient test results and the source of the results (IDEXX Reference Laboratories, ProCyte Dx*,
Hematology Analyzer, SNAP* tests, etc.)

VetConnect PLUS does not store or display financial information, phone numbers, addresses, or
any personal information from your practice, staff, or clients.

Setup

Prerequisites
To activate VetConnect PLUS, your practice must have:

Internet access at the workstation where you want to view VetConnect PLUS.

Windows®Internet Explorer® 7 or later must be installed on each Cornerstone workstation. It does
not have to be the default Internet browser.

If you want to view in-house results, you must have IDEXX SmartLink* technology to provide
bidirectional flow between Cornerstone and your IDEXX VetLab Station. In addition, IDEXX
SmartService* Solutions must be set up for the IDEXX VetLab Station. Call your IDEXX Connectivity
Consultant at 1-877-256-8457 to order IDEXX SmartLink for your IDEXX VetlLab Station if your
practice does not already have it.

If you want to view IDEXX Reference Laboratories results, you must have IDEXX SmartLink*
technology to provide bidirectional flow between Cornerstone and the IDEXX Reference
Laboratories. Call your IDEXX Connectivity Consultant at 1-877-256-8457 to order IDEXX SmartLink
if your practice does not already have it.

A VetConnect account with administrator user name and password. Call VetConnect PLUS Client
Services at 1-888-433-9987 to request an account if your practice does not already have one.

Activating VetConnect PLUS
You can activate VetConnect PLUS immediately following installation of Cornerstone 8.3 software or
anytime after that. After you activate VetConnect PLUS from within Cornerstone, activate VetConnect
PLUS from your IDEXX VetLab Station (if applicable).
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To activate VetConnect PLUS:

1. From the Cornerstone Practice Information window (Lists> Practice), select your practice name,
and then click Update. This must be your primary practice if you are a Multi-Location Single
Database user.

2. From the Account information for drop-down list, select VetConnect PLUS.

3. Ifyou are a new IDEXX Reference Laboratories user, select the VetConnect option, enter your
practice’s VetConnect administrator user name and password, and then click Submit to Activate
VetConnect PLUS.

OR

If you are an existing IDEXX Reference Laboratories user, the VCAgent option should be selected
and your VetConnect user name and password should be completed. Click Submit to Activate
VetConnect PLUS.

4. Read the agreement, and then click Accept.
A message states that IDEXX Reference Laboratories historical data will be uploaded.

5. Click Next.

6. IDEXX VetLab Station only: A message giving you the option to print instructions on uploading data
displays. Click Yes to open the printable message or No to continue.

7. Click Finish.

8. A message states that activation is complete and that data upload will continue. Close the message
window.

The upload of IDEXX Reference Laboratories historical data that began during activation will continue,
with the most recent results uploaded first. Upload can take up to 24 hours, depending on the number of
results being uploaded. You can continue to use Cornerstone software during the upload; Cornerstone
performance will not be affected.

To upload data from your IDEXX VetLab Station:

1. On the IDEXX VetLab Station, tap Settings, and then select the VetConnect PLUS tab.
2. Tap Activate VetConnect PLUS.

3. Accept the VetConnect PLUS user agreement.

4. Enter your VetConnect user name and password.

5. Tap Next. A confirmation message is displayed. Close the message.

Data is uploaded in reverse order, starting with your most recent results. You can continue to use
the IDEXX VetLab Station during the upload.

Disabling Access to VetConnect PLUS

If you prefer to use the standard Cornerstone 8.3 workflow for viewing results, you do not need to
deactivate VetConnect PLUS. All your test results are always available in standard Cornerstone 8.3
windows. However, if you want to disable access to VetConnect PLUS, you can do so in Cornerstone.

To disable access to VetConnect PLUS:

1. From the Cornerstone Practice Information window (Lists> Practice), select your practice name,
and then click Update.

2. From the Account information for drop-down list, select VetConnect PLUS.

3. Select Disable VetConnect PLUS online services, and then click OK.
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Use

You can open a patient’s IDEXX Lab Report in Cornerstone and then select the VetConnect PLUS tab in
the Detailed Lab Results Set window.

To use VetConnect PLUS from the IDEXX Lab Report:
1. Inthe Cornerstone software, open the patient record, and then use your preferred method to open

an IDEXX Lab Report ﬂ that contains the test results you want to see (for example, double-click an
IDEXX Lab Report on the Summary tab in the Patient Clipboard).

The Detailed Lab Result Set window opens.

2. Select the VetConnect PLUS tab.

See “Understanding the VetConnect PLUS Tab” below for more information about using VetConnect
PLUS features.

3. When finished, close the results window.

Understanding the VetConnect PLUS Tab
Results in VetConnect PLUS are organized by date

VetConnect PLUS displays the selected result in its main window. All other results in the patient’s history
are also available, organized by date. Click a date tab to open the results.

JAK| SABINE

~ Trending

=
11/13/2011 (Crder Racshad) IDEXX Referance Laboratories 5/8/11 _r" /11l
B 117132011 @ 7:90 am (Last Updatsd) Shew Datails A

RBC £.23 5.5 - &5 ML 1 £.91

Results for the same analyte are displayed side by side

VetConnect PLUS automatically displays both the selected result and other results for the same analyte
that it found in patient history so you can easily compare them.

In the example below, hematocrit results 11/13/11, are currently selected. VetConnect PLUS also found
hematocrit results for 5/8/11 and 1/17/11.

JAKI SABINE

i NOWV 43 | MAYB | JAN 17 ~' Trending

=
& 117132011 (Order Ascsived) IDEXX Reference Laborataries 5/8/11 W /27711
11/13/2011 @ 7:40 am (Last Updated) Shaw Datails ,A.

ful 1 6.91

Hematocrit 42.8 37 <55 % ] T ] 47.6 55,1
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Click Trending to graph selected analytes

Select one or more analytes in the left column and then click to display graphs on the right. The
gray rectangle behind the graph indicates the reference interval.

JAKI'SABINE

NOV 13 | MAYSE  JAN 17 ~ Tranding

- \sissa0n ce e | TTENding Graph
117132011 @ 7:40 am (Last U -\
RBC 6.23 5.5 - 8.5 Mfpl .-

Hematocrit 42.8

w

B— Trending Interval I——
Hemoglobin 15.4 12 - 18 g/dL [N m
MOV L] 50 - 77 fl 1 .

MCH 24.7 19.5 - 26.0 pg 1 e

MCHE 36.0 32 - 36 g/dl 1

Tips:
e You can click Trending before or after you select the analyte names.

e Click Eto open the trending graph in its own window.

Toolbar buttons
The following buttons are at the top of the VetConnect PLUS tab:
Patient Tools

Displays patient information and indicates the patient’s species, including:

e Feline
e Canine
e Equine

e Exotics and other species

R a
n Displays all diagnostic results for the current patient. A green plus indicates
there are possible matches to the current patient record that should be
reviewed.
Result Tools

H Print the open result

Share a result with IDEXX Pet Health Network* Pro

n Send the open result by email

W Tiending Graph results for selected analytes
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Send a client-friendly report for a canine or feline patient.

These reports have been designed to communicate information about the
patient in a format that clients will find clear and engaging. Available reports
include the Preventative Care Summary (feline or canine) and SNAP* 4Dx*
Plus Summary (canine only).

n View the VetConnect PLUS communications log, which shows details of
diagnostic lab results and client-friendly reports that have been emailed,
printed out, or shared through Pet Health Network Pro for the patient. The
log includes a record of any comments that were sent with results or
summaries.

Note: The information in the VetConnect PLUS communication log is not
viewable elsewhere in Cornerstone. If you want to have a copy of a
communication in the Cornerstone patient history, print it as a PDF and
attach it to a medical note.

Most buttons are toggles
If clicking a button opens a dialog box, window, or menu, click the same button to close it.

Additional VetConnect PLUS Features
VetConnect PLUS is updated independently of Cornerstone. From time to time, you may see new
features in VetConnect PLUS even though you have not upgraded your Cornerstone software. To learn
about the latest VetConnect PLUS enhancements and new features, periodically do the following:

1. Open any lab result on the VetConnect PLUS Lab Results tab of the Detailed Lab Results window.
2. Scroll to the bottom of the results, and click Customer Support.
3. Inthe Getting Started area, click the tutorials for getting started link.
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Note: Linking Patient Sex, Species, and Breed Values—In Cornerstone 8.3, an update to the connection
between IDEXX Cornerstone* Practice Management System and IDEXX VetLab* Station requires linking
some patient sex and species values in a one-time setup screen. Cornerstone will attempt to
automatically link values, but you may be prompted to link the values when you log in to the 8.3
software.

For instructions, see “Linking Cornerstone Values with Laboratory Values” on page 45.

Improved Communication with IDEXX VetLab Station

IDEXX SmartLink* technology in Cornerstone 8.3 software offers these enhancements (excluding
module):

e You no longer need to make sure the communication program is running on a specific workstation.
The IDEXX Application Service automatically handles all communications and must be running on
the server.

e Cornerstone 8.3 software automatically detects all IDEXX VetLab Station computers on the practice
network.

e Improved handling of work requests for practices with more than one IDEXX VetLab Station. By
default, all test requests are sent to all IDEXX VetLab Station computers on the network. However,
you can specify default computers to be used for specific workstations and practice locations. When
ordering tests, staff can always override these defaults and choose from the entire list of IDEXX
VetlLab Station computers.

e When patients are checked in through the Cornerstone Census List, the patient information is

automatically displayed on the Census List of the IDEXX VetLab Station computers associated with
the check-in practice or the check-in workstation.

Setup

To specify default IDEXX VetLab Station computers for a practice and/or workstation:

1. In the Practice and Workstation Defaults navigation pane (Controls > Defaults > Practice and
Workstation), select IDEXX VetLab Settings.

I® Practice and Workstation Defaults g@ﬁ

@ Boarding [A] IDEXX ¥etLab Station Settings
@ Check-in
Client Select IDEXX VetLab Stations

Daily Entries Report
Daily Planner

Daily Planner
Dacuments

End Of Period
Estimnate

IDEXX ¥etlab Settings
Imaging

Ireventory

Invoice

Inwaice Ttem

Labs

Messages

Passwords

Patient

Patient Advisor

= Petformance Tracker [v]

I3

“wiorkstation: /18432 IVI

w

‘etlab Station:
Use al

®

Station 1
Station 2

&

Apply ] [ o] ” Cancel ]
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IDEXX VetLab* Station

Multi-Location Single Database only: To specify a default IDEXX VetLab Station for a practice
location, select the practice name from the Practice drop-down list, and then select the IDEXX
VetLab Station from the VetLab Station box.

To specify a default IDEXX VetLab Station for a workstation, select the workstation name
(workstation names are displayed on each IDEXX VetlLab Station) from the Workstation drop-down
list, and then select the IDEXX VetLab Station from the VetLab Station box.

Note: If practice and workstation settings conflict, the workstation settings take precedence.
Click Apply.

Repeat steps 2-4, as needed, for other practice locations and workstations.

When finished, click OK.

If default IDEXX VetLab Station computers have been specified, a staff member requesting a test can
override the defaults and select from the entire list of IDEXX VetlLab Station computers.

To select an IDEXX VetLab Station when requesting a test:

1.

Start the laboratory request using your preferred method. For example, click the Lab Requests and
Results button T on the toolbar. Then, on the Lab Requests and Results window, click New.
On the New Lab Request window, select INCLINIC.

If a single IDEXX VetlLab Station is available, the window displays its name. If more than one IDEXX
VetlLab Station is available, the name is replaced with “Multiple” or “All.”

™ New Lab Request
Patient information
Ok
Patient D |BE32 -
Request details Spell Check

Lab: |INCLIMIC | | IDE VetlLab In-clinic Laboratar - Requisition
Staff: |Schulze, DYM Corin [ CS) (v
Datedtime: 02/1E/2012 054521 PM | Drawn by

editview

Instructions:

Profiles/tests:

Itern |3 Iterm Description Profilestsst Price | Center| [Q0[~

e

w

3. Click the edit/view link. A list of all available IDEXX VetlLab Station computers is displayed.
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™ Select IDEXX Vetlab Station

Select IDEx Wetlab Stations

[JUse al

Station 1
Station 2

IDEXX VetLab* Station

4. Select one or more IDEXX VetLab Station computers (or select the Use all check box), and then

click OK.

5. Complete the order as usual.

After the test has been run on one IDEXX VetlLab Station, the request is removed from all of the

others to which it was sent.
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Antech Diagnostics® Module

Overview

In Cornerstone* 8.3 Practice Management Software (excluding the Mobile Computing module), the
Antech Diagnostics® laboratory module has been updated to enable online test ordering and automatic
result download. The updated module offers the following enhancements:

e The Antech Diagnostics profile list (a list of commonly used Antech order codes) is updated
automatically by Antech Diagnostics, as needed. The IDEXX Cornerstone* Practice Management
System software alerts you when Antech updates its list prices.

e You can specify an automatic markup percentage for Antech Diagnostic profiles, just as you can for
IDEXX profiles.

e When you order an Antech Diagnostic profile, Cornerstone software checks the order for accuracy
and then generates a bar-coded Antech Diagnostic order form appropriate for the profile type. Print
the form and include it with your specimens.

e When your order is complete, Cornerstone sends the profile request to the laboratory electronically.

e Results are automatically downloaded from the laboratory approximately once per hour.

Setup

Activating the Antech Diagnostics Laboratory Module
Contact your IDEXX Cornerstone Sales Representative at 1-800-283-8386 for information about
purchasing and activating the updated Antech Diagnostics laboratory module. Please note that the
activation process includes reinstalling the Cornerstone software. After the updated module has been
activated, follow the procedures below to take advantage of the latest enhancements.

You must also perform a one-time setup of your Antech login information in the Practice Information
window.

To access Login/Password Management settings:

1. Onthe menu bar, select Lists > Practice. The Practice List dialog box appears.

2. With your practice name selected, click Update (or double-click the practice). The Practice
Information dialog box appears.

3. On the Practice Information window, in the Login/Password Management area, select Antech
Reference Lab Results from the Account information for drop-down list.

4. If you already have Antech set up in Cornerstone, click Apply Primary Practice Settings. The
account information boxes are automatically completed.

5. If you don't have existing Antech account information, enter the information provided when you set
up your account.

6. Click Test. Then, when the Login Settings Passed message appears, click OK.
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Linking Patient Sex, Species, and Breed Values
Patient sex and species values for all laboratories in Cornerstone, including Antech Diagnostics, must be
linked to Cornerstone values. Linking breed values is optional, but it is recommended if you want your
patient’s breed listed on your Antech result report. For instructions, see “Linking Cornerstone Values with
Laboratory Values” on page 51.

Setting Pricing Options
Set or change the default pricing options on the Antech Diagnostics Lab Information window.
You can also manually set profile prices or change the markup percentage. Set or change these values
on the Antech Diagnostics Lab Item Price Update window.
To set default Antech pricing options:

1. From the Lab List (Activities > Lab Work > Laboratories), select the Antech Diagnostics
laboratory, and then click Update.

I® Lab Information for Antech Diagnostics El@
Lo,

Cancel

Address:

!

City:
State/prov Iz‘ Postal code:
tanually enter requisition D'z Use as default lab V| Pintful page # Copies: 1%
Use requisition |0 ranges X /| Print labe # Capies: 1+
- | Review results before posting X i
@ sz patient 1D for requisition 1D Print tube label ~ # Copies:
/| Require sample drawn by info
Next D d
EndID Markup percertage: %
Wty Hezes Feai t Automatically update prices
G fEHEEs Allow prices to go down
Begin D
g Ulse Favorites list
EndID

V| Use special actions

] 7 H . .
Unit: [Comman units Hide request screen if special action

[+]
DR =] | Wwham in invoicing if Mot Fleq results exist
[+]

Cumulative display: | Descending

2. Set pricing options in the Antech online area, in the lower right cormner of the window, and then click
OK.

If you select Automatically update prices, your practice prices are recalculated automatically,
based on the markup percentage you specified, whenever new prices are downloaded from Antech
Diagnostics. The prices will be updated in Cornerstone software during the next End of Day
processing.

To set Antech prices manually:
1. On the Activities menu, select Lab Work > Update Antech Lab Item Prices.

The Antech Diagnostics Lab ltem Price Update window displays your current price, the price
charged by Antech, and the new calculated price.

2. Manually update individual prices, or change the markup percentage to calculate new prices.
When finished, click OK.
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Use

Viewing and Updating Profiles

To view or update Antech Diagnostics profiles:

1. From the Profile List (Activities > Lab Work > Profiles), select the Antech Diagnostics laboratory
from the Lab drop-down list.

2. To view or update a profile, double-click the profile name, or select it and then click Update.

I Profile List
Profile information
Name: CYTOLOGY Lab:  wamast v] Only profiles that can be requested New
Profile Mame Lab ID Profile Type Order # | Item IO | Itemn Description -~
Cyclosporine xaeast Profile/Panel 5168702 Delete
CYTOLOGY xaeast Profile/Panel CYTO CYTREF Cytology - RefLab i
D - DIMER wagast Frofile/Panel  T360
DERMATOPATHOLOGY agast Profile/Panel  DERM
Diabetes Monitaring Panel Hagast Prafile/Panel SA800
DIARRHEA PROFILE nagast Profile/Panel  AED70
DIFFERENTIAL wagast Frofile/Panel  T355
DIGIT LIMBS WHOLE ORGANS xaeast Profile/Panel  DIGIT
DIGOXIN wagast Frofile/Panel 1735
DILANTIN wagast Frofle/Panel 516245
DISTEMPER IgG.1gM xaeast Profile/Panel 1555
Distermper PCR xaeast Profile/Panel 516501
DISTEMPER SMEAR. FA wagast Frofle/Panel 516250
DISTEMPER WACCINAL TITER wagast Profile/Panel  TEEO
DISTEMPER/PARYO laG naeast Profile/Panel TE65
Dog 'wellness Profile wamast Profile/Panel SABDG -

3. Modify details on the Profile Information window, as needed.

I Profile Information for CYTOLOGY =]
Profile information
— . - Ok
Lab: | racast | Z- Antech Diagnastics [East] Profile type: | Prafile/Panel v -
Profile name: T TOLOGY Drder number. CTTO0
This 12 2 Cytology/Histology profile Instiument type: 2
[ Include in favorites list Can be requested

Tests/subprofiles

Type Order Mbr Profile Mame: Test Name
_lSubprof\Ie |813 |E13 | ﬂ
2
3
: +|
]
E
7
Invoice items
1D Description Price ‘ Type |

Note: When the This is a Cytology/Histology profile check box is selected, the Cornerstone
software prompts for additional information whenever you order a cytology or a histology profile. Do
not clear this check box for any cytology or histology profile.

4. Click OK.

Ordering a Profile
When you order an Antech Diagnostics profile, Cornerstone 8.3 software generates an Antech-specific
form. However, the form for cytology/histology profiles is different from the standard Antech Diagnostics
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form. For that reason, you cannot combine cytology/histology profiles with other profiles on the same
form.

To order an Antech Diagnostics profile:
1. Start a new laboratory request using your preferred method.
On the New Lab Request window, select the Antech Diagnostics laboratory.

2
3. Under Profiles/tests, enter the item ID for the profile or press F2 to search for and select the profile.
4. Click OK on the New Lab Request window.

5

If you ordered cytology or a histology profile, provide the additional information requested in the
Information for Antech Cytology/Histology Lab Test window, and then click OK.

I Information for Antech Cytology/Histology Lab Test
Provide the following for thie Cytology/Histology Lab Test
Mumber of Containers:* ]
— Cancel
Container Size:* ||

Total Mumber of Specimens:*
Special Stain:* Mo v

Requested Patholagist(z):

SourcesSite:

Biopsy Typer® [] Excisional  [] Incizional
[] Neede [] Endascopic
All Tissues Submitted® Mo v:

Previous Biopsy/Cutology Accession Mumber:

Patient Histan:*

Cornerstone validates the request and submits the request to the laboratory electronically.
The Print Lab Request dialog box opens.

6. If your request is complete, select print options and click Print.

If this is a cytology/histology order, mark the specimen site (if applicable) on the dorsal/ventral
images at the bottom of the printed form.
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ANTECH
Diagnostics

Rieq be: LORID

000004

Aoocuntin:
The Smart Pracice
1 Smart Drive

Smart iy, VA4
Fhore: (123) 4567250

anemonz

PMS ID: sasz
Doctor: Angrd , DV, Leonard
Owner Last Nama: Adams

Spaciea; C-Cane
Ersed:

Requestsd Pathologlsta:

other Comments:
Patient History-See flie.

Source/Sita:

Previous Blopsy/Cytology Accesslon
Blopay Type: M
All Tissuss Submitted: No

Owner First Name: Kimoeny Sex:  om
Pat Nama: Bamzaiot Age: 9y
we OwsO=a0s0r0c0x0s0fr0vOveOre0fF Oowr Or=0 = 0 &7 [J omer
r-
3

3 L ou o o©oa F F B & & RE Bce s ater
Ordered Tests:

cade hame

oo CYToLDaY
LBLESCHY  containers Submitted- 1 30mL oL o e Spacimans Submittsd:- 1
Number of Casseties:

Container # Sottie Lavel Plece(s) Sectionis) Cassette #
Notss:
Special Staln: No

Antech Diagnostics cytology/histology order form

8. Include the printed form with the specimens you send to the laboratory.

Updating a Pending Test Request

Antech Diagnostics® Module

You can update a pending Antech Diagnostics request until specimens have been received at the
laboratory. After specimens have been received, the Pending Request window displays a notification
message stating that test updates are no longer allowed. If you have questions or concerns about the
test, contact the laboratory directly.
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Version 8.3 of the IDEXX Cornerstone* Practice Management System offers many additional
improvements to laboratory requests and results, both for in-house and reference laboratory orders.

Specifying Staff IDs for Laboratory Requests
You can now specify a default staff ID for laboratory requests, including a “No default staff” option. Use
the new Labs panel in the Practice and Workstation Defaults window.
To specify a default staff ID for laboratory requests:

1. In Practice and Workstation Defaults (Controls > Defaults > Practice and Workstation), select
Labs.

~
I Practice and Workstation Defaults E]@
Account | Labs
@ Alerts
i@ Appaintment Schedule

Lab Requests

7 L
- Boarding Use biling staff on a new lab request

i Check-in
Clignt.
Daily Entries Repart

Staff to use on requests without Special Action

Specific staff - Siaff 1D:|C5 Corin Schulze, DYM
i default staff

Last staff used on workstation

Specilic staff

DCaily Planner
Daily Planner
Documents
End Of Period
Estimate
IDEXY Vetlah Settings
Imaging
Irvventory
Invoice
Irwoice Ttem
Labs
Messages
Passwords

&

&

&

2. Forrequests associated with special actions, select the Use billing staff on a new lab request
check box to designate that the billing staff on the Patient Visit List or the invoice should be used as
the default staff ID on the request.

Currently, if this option is not selected, then the default staff ID for special action requests is the ID of
the last staff member who performed a lab request on the workstation.

3. For lab requests not associated with special actions, select from the following options:
¢ No default staff—The person creating a request will need to select a staff ID for each request.

o Last staff used on workstation—The default staff ID will be the ID of the last staff member who
created a request on the workstation.

e Specific stafi—Type a default staff ID, or press F2 to search for and select the ID.
4. Click OK.

Result Download and Result Matching

¢ In Cornerstone 8.3 software, the server automatically handles all communications. It is no longer
necessary to make sure the communication program is running.

¢ Aslong as the Cornerstone database and IDEXX Application Service are running, laboratory results
will be received even when the Cornerstone 8.3 application itself has been shut down.

o Laboratory results are displayed in bolder text in medical notes and reports, making them easier to
read.
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The Diagnostics tab in the Daily Planner window allows you to perform callbacks from the IDEXX
Lab Report entries. You can create and update a single callback for all results on the IDEXX Lab
Report, rather than updating the same callback multiple times.

When ordering tests from the Patient Visit List or invoice, the laboratory order form is not printed until
the window is closed. The software now generates a single combined form containing all ordered
tests (when possible—larger reports may not be combined); you no longer have to update a call
back for each individual test.

Results received from IDEXX Reference Laboratories are matched to requests based on the top-
level profile code, not on the component test codes. This means that if a component code within a
profile has changed, the results for that component are no longer returned as “not requested,” as
long as the top-level profile code remains the same.

Results returned from IDEXX Reference Laboratories and from IDEXX VetLab Station can be
matched on the patient ID if the patient ID was submitted with the request.

The IDEXX Message Center lists all recently returned results from IDEXX Reference Laboratories and
the IDEXX VetLab* Station. Click the IDEXX Message Center button TZ on the toolbar to open the
window, and then click the Lab Results tab. The button appears in red and black when new lab
results and/or Pet Health Network* Pro messages have been added since the last time you looked
at the message center.

u IDEXX Message Center x|

LabResults | Client Messages [27] o =

Search for a patient

Il
TUESDAY, SEPTEMBER 25, 2012

HOOCH ADAMS (3596) 03:20 pm
Hematology 0P

HOOCH ADAMS (3596)
Chemistry
Hematelogy
Immunoa ssay

03:15 pm

ltems 1-2 072

IDEXX Lab Report

When an IDEXX Lab Report is available, a single line for the report is displayed on the Summary tab
in the Patient Clipboard window and in the Daily Planner window. There are no longer separate lines
related to each test template in the request. However, the Text and Lab tabs continue to display
separate lines for each template.

When you double-click an IDEXX Lab Report in the Patient Summary or Daily Planner, the results
open in the Detailed Lab Results Set window, which contains three tabs. Each tab provides results
in a different format: the IDEXX Lab Report; detailed lab results; and VetConnect PLUS. See the
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“VetConnect* PLUS” section starting on page 35 for more information about the VetConnect PLUS

tab.

I Detailed Lab Result Set

===
B =
[ elConnect PLUS Lab Resulls ﬂ IDE%% Lab Fisport | Lab Resulls|
Hematology (Posted) - 1
Patient D: 6692 Barksalot Neutered Male 8'%rs. 2 Mos
Owner. Kimberly Adarns Canins Retiever, Golden 40 pounds
Print
Status; |Fosted [w] 10/4/2000 Mondsy  230PM Dr. Coonin Schulze, DYM
ReqD: 3208 IDES VetLab In-cnic Laberatory W=D
Test | Results ReferenceRange | Low | MNomal | High [
RBC = B5MAL 55-85 [ [ | T ]
HCT = 405% 37-55 [ I | I ]
HGE = 14Bg/dl 12-18 [ I | | | ]

Linking Cornerstone Values with Laboratory Values
When you log on to Cornerstone 8.3 software, Cornerstone prompts you to link the Cornerstone values
for patient sex and species with the sex and species values for IDEXX VetLab* Station. This will save you
time when ordering tests—if you do not link the sex and species values, you will be prompted to link
values for the specific patient when you order a test.

You must also link patient sex and species values for each reference laboratory. For reference
laboratories, you have the option to link breed values as well.

To link Cornerstone values to IDEXX VetLab Station and reference laboratory data:
1. On the Activities menu, select Lab Work > Setup Lab Links > Link Sexes.
2. From the Lab drop-down list, select IDEXX VetLab Station.

Cornerstone values are displayed in the left column, and IDEXX VetlLab Station values are displayed

in the right column.

I® Link Sexes

BEIX]

Lab: | IDEX Vet ab Station
Link Sex to I¥LS Sex

Sex Description

VLS Sex Description |

Iale

Female
Meutered Male
Spayed Female
Undetermined
Unknowir
Gelding

Mare

Stallion

FEMALE_INTACT
MALE_MEUTERED
FEMALE_SPAYED

Cancel

ARA[ARREA[AAAR
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For each row, select a value in the right column that corresponds to the Cornerstone value in the left
column.

When finished, click OK.
Repeat steps 1-4 for each reference laboratory in the Lab drop-down list.

When you have finished linking values for sexes for all the laboratories, on the Activities menu,
select Lab Work > Setup Lab Links > Link Species.

Follow the general steps above to link species values to IDEXX VetlLab Station and reference
laboratory data.

(Optional) To link Cornerstone breed values to reference laboratory breed values:

1.
2.
3.
4.
5.

On the Activities menu, select Lab Work > Setup Lab Links > Link Breeds.

From the Lab drop-down list, select the reference laboratory.

From the Species drop-down list, select the species.

For each row, select a breed value in the right column that corresponds to the Cornerstone value.
When finished, click OK.

Note: Repeat the steps above for each additional reference laboratory you want to link.
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Imaging Overview
Cornerstone* Imaging
DICOM Imaging and Diagnostic Imaging

IDEXX-PACS* Imaging Software (formerly IDEXX Digital Radiography)
Modality Worklist Integration
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Imaging Overview

There are three levels of imaging features available in the IDEXX Cornerstone* Practice Management
System:

Cornerstone Imaging—With only the Cornerstone software, you can import, view, and send by email
basic types of images and attach them to the patient’s medical record.

DICOM Imaging—With the addition of DICOM Imaging, you gain the ability to use the DICOM
standard to import and send images, as well as a number of advanced imaging features.
(Diagnostic Imaging, available with previous versions of Cornerstone, includes a similar set of
features.)

IDEXX-PACS—IDEXX-PACS* Imaging software adds the ability to capture radiographs, along with
features to make the image capture process more efficient. Of course, you have all the Cornerstone
Imaging and DICOM Imaging features as well. (In previous versions of Cornerstone, this imaging
level was called IDEXX Digital Radiography.)

You can add image request and results functionality that helps you more fully integrate your practice’s
imaging devices with Cornerstone:

IDEXX SmartLink* Technology (used with IDEXX-PACS software)—SmartLink integration lets you
request radiographs quickly and easily from anywhere in your practice, reducing double data entry
and reducing missed charges.

Modality Worklist Integration (used with DICOM Imaging or Diagnostic Imaging)—Modality Worklist
integration lets you request radiographs from non-IDEXX imaging systems, such as ultrasound and
CT devices. As with SmartLink, Modality Worklist integration also helps to reduce missed charges
and add completed images to the medical record. However, the exact level of billing and medical
record integration depends on the capabilities of the device.

The table on the next page offers a more detailed view of the features available in each level of imaging.

Cornerstone 8.3 What’s New 54



Imaging Overview

Cornerstone DiCOM IDEXX-PACS IDEXX-PACS DICOM
Imaging Imaging with Imaging
IDEXX with
SmartLink Modality
Worklist
Integration
Image Explorer X X X X X
Image Viewer X X X X X
Create patient CD X X X X X
Send image via Email X X X X X
Add basic annotations X X X X X
Import basic image types
(JPEG, BMP, TIFF) X X X X X
Scan images X X X X X
Import videos X X X X X
Telemedicine X X X X X
DICOM: Send, receive,
import, query/retrieve and X X X X
auto-route
Use advanced image
X X
enhancement tools
Capture stills from videos X X
Multi-image layout by X
modality
Apply preset window/level X X
adjustments
Capture radiographs X X Xt
Create image request X X
Automatically capture
. X X
charges for requested images
View request status X X¥
Prompt you to bill for X X
non-requested images
View completed image X X¥
Save image to medical record X X

T You can capture images with a non-IDEXX imaging system as part of an integrated work flow with Cornerstone.

t Use of these features depends on the capabilities of the device and its software.
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Use

Enhanced Crop Tool
More easily adjust the crop rectangle:
e To adjust the border, click and drag an edge of the rectangle.
e To rotate the crop area, click and drag one of the corners.

e To move the crop area, click and drag anywhere within the border.

An image with a slightly rotated crop outline

Imaging Connections Status Bar

The IDEXX Cornerstone* Practice Management Software on your computer is connected to other
computers inside and outside of your practice. The status bar displays the current state of the
connections that are related to imaging.

) prcom

e Database

) mwL

e Smart Service

eTelemedicine

e SmartLink

To view overall connection status:

The Connections status bar is displayed in the lower left of the Image Explorer window. It is also
displayed in the Imaging Dashboard (Diagnostic and Digital Radiography only). The color of the icon
indicates the status of all of the imaging connections for the computer.

Red—One or more of the connections that have been set up is not running.
Yellow—One or more of the connections requires attention.

Green—All of the connections that have been set up are running.
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To view status for each connection:

> Click Connections in the lower left of the Image Explorer window (or Imaging Dashboard, if you
have an IDEXX Digital Imaging system). The status bar opens.

Connection status details:

A colored status icon is displayed for each connection:

Red—Not running

Yellow—Requires attention (for example, a yellow status for the DICOM® connection indicates a
problem sending or receiving images)

Green—Running

Gray—Not set up on this computer

Note: If you move your mouse over an icon, text with status details appears.

The connections are:

DICOM—This icon appears only on the computer that is the server for your Cornerstone
network. It shows whether IDEXX DICOM services, which sends and receives DICOM images, is
running. It also shows whether any failure has occurred in sending or receiving images. You can
use the links next to the icon to start or stop DICOM services or to view the DICOM queue.

Note: This icon is activated only if you have DICOM Imaging or Diagnostic Imaging.

Database—If you have a server/workstation set up, each computer is connected to the database
that resides on the server. This icon shows the status of that connection.

MWL—This icon does not apply for the current version of Cornerstone.

SmartService—This status icon appears only on the Cornerstone server. It shows the status of
your connection to IDEXX SmartService* technology, which allows you to upgrade your software
over the Internet.

Telemedicine—If you have set up a connection to one or more telemedicine providers, this icon
shows the status of those connections.

SmartLink—If IDEXX SmartLink* technology is set up for your IDEXX Digital Imaging system, this
icon shows the status of the connection between the IDEXX-PACS* Imaging Software and the
rest of the Cornerstone software.
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Note: If you have the DICOM Imaging or Diagnostic Imaging modules, you have the feature described in this
section as well as the features described in the “Cornerstone* Imaging” section that starts on page 56.

Use
Improved DICOM® Queue

The DICOM® queue shows the progress of images that are being sent or received using the DICOM
standard. The queue has been reformatted for better readability.

When you send images via DICOM, the DICOM queue displays detailed information for each image.
Also, the queue shows the status of DICOM services and gives you the ability to restart DICOM services
as needed.

W s

) micoe seariea

To use the DICOM queue:

» On the menu bar, select Activities> Imaging> DICOM Queue. The DICOM Queue window
appears.

To view the status of the DICOM connection and restart if needed:

A status icon appears in the lower left of the DICOM Queue window. The icon tells you about the status
of the DICOM connection through color and text:

* Green (DICOM started)—IDEXX DICOM services are running and the queue does not contain any
sent or received images with a status of Failed.

* Yellow—Check the queue for information about sent or received images that have failed. You may
see this status when DICOM is started or when it's stopped.

* Red (DICOM stopped)—The DICOM server is not running. Click Restart DICOM Services to restart
DICOM services.
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Note: If you have an IDEXX Digital Imaging system, you have IDEXX-PACS* Imaging Software within
Cornerstone, which includes the features described in this section as well as the features described in the
“Cornerstone* Imaging” (see page 56) and “DICOM Imaging or Diagnostic Imaging” (see page 58) sections.

Use

Changes to the Image Capture Window

The Image Capture window has been redesigned in version 8.3 of the IDEXX Cornerstone Practice
Management System. In addition to new features like Image Coach* tools and the technique prompt
(discussed below), the reprocess feature has moved.

If you have an IDEXX-DR* 1417, IDEXX I-Vision DR*, IDEXX EquiView* system, or an IDEXX-CR* 1417
Digital Imaging System with ClearCapture DX* Image Processing technology, you have the reprocess
feature. In previous versions of Cornerstone, the feature was located on the right side of the Image Capture
window. In version 8.3, you access the feature by clicking the Reprocess button lﬂ at the top of the
window.

The Image Capture window

Image Coach* Tools

If you have an IDEXX Digital Imaging system, several new features on the Image Capture window can
help you:

e Train new technicians.

e Encourage standard radiography practices for all staff members.

e Troubleshoot problems related to under or overexposed images.
Real-Time Positioning Aid

Before you capture a radiograph, you can see a photograph that shows how the patient should be
positioned. Hints for proper positioning also appear.
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To display the positioning aid:

» On the right side of the Image Capture window, click Position . A photograph appears,

showing the proper patient positioning. Next to the photo is a text description of the positioning,
along with recommended beam center, measurement point, and other variables, as well as other
hints for obtaining the best quality radiograph of that view.

Positioning photograph and text
Reference Radiographs
The Image Coach contains example radiographs for frequently captured exam types.

You can see the reference radiograph before you capture, or view it side by side with your radiograph
after capture.

To display a reference radiograph before you capture:

» On the right side of the Image Capture window, click Reference ===l An image
appears, showing an example of how a radiograph should look for the selected view. This
radiograph is provided to assist in taking the radiograph correctly, not as an example of any
particular pathology.
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Reference radiograph

To compare a radiograph to the reference radiograph:
» At the top of the Image Capture window, click Compare to Reference . Your radiograph
appears on the left and the reference radiograph appears on the right.

Comparing a radiograph to a reference example

Technique Prompt

Before you take each radiograph, the capture screen can display the recommended technique (kVp and
mAs) that you should use for that exam type. These technique settings are displayed on the capture
screen in large type that’s easy to view from a distance. To see recommended technique, you need to
select either the weight of the patient or the thickness of the body part.

Note: If you're using an IDEXX I-Vision DR* or IDEXX-DR* 1417 system, your technique chart is set up
by weight rather than thickness. If you want to change to a thickness-based chart, contact IDEXX Digital
Imaging Customer Support at 1-877-433-9948.
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To view the suggested technique for a radiograph you are about to take:

» On the right side of the Image Capture window, select the weight of the patient or the thickness
of the body part to be radiographed. The kVp and mAs for that view appear in large numbers
above the thickness selection area.

ABD - R Lat

/0. 3.5.

| ¢ Position [#] Reference Capture

The technique prompt and the thickness (or weight) selection area

To set up technique prompt values:

1.
2.

On the menu bar, select Controls> Defaults> Imaging. The System Settings window appears.

On the left, click Exam Trees and then click Capture technique chart. The header row for a table of
technique chart values appears.

IMPORTANT: Do not change any other settings related to the exam tree without consulting IDEXX
Digital Imaging Customer Support.

WP raging Configuration

St et M——

Capture technique chart

In the Unit of Measurement drop-down menu, select the unit you use to measure patient weight or
thickness of the body part to be radiographed.

Click Add. A blank row appears in the table.
In the Measurement Range text box, type a thickness range (in centimeters).

In the kVp and mAs text boxes for each anatomical region, type the values from your technique
chart.

Note: The software will extrapolate from these three general region settings in order to display
technique values for all exam types.
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7. To enter values for another anatomical thickness, click the Add button and repeat steps 5 and 6.
To delete a row, click in the row to select it and then click Delete.
9. Click Save to save and close the System Settings window.
10. Click Close in the upper right of the Cornerstone window to close the software and then open the
software again for the changes to be applied.
Exposure Index

After you capture a radiograph, a scale on the Image Capture window displays the level of x-ray
exposure. This exposure index shows whether the proper amount of x-rays to produce a diagnostic
image reached the detector or screen or if the image was improperly exposed.

Exposure

The exposure index is primarily meant to provide troubleshooting information for nondiagnostic
radiographs. For example, if you have an all-white or all-black image, a high- or low-exposure index
reading is a valuable piece of information to have when discussing solutions with IDEXX Digital Imaging
Customer Support.

More Powerful IDEXX I-Vision Mobile’ Application

The IDEXX I-Vision Mobile* application offers a redesigned viewer with more image manipulation
features, larger images, and improved zoom. The redesigned viewer is shown below.

Mobile viewer, upper toolbar expanded

The redesigned IDEXX I-Vision Mobile viewer includes an upper toolbar and a lower toolbar.
The upper toolbar contains three sections:

e Top: Image thumbnails and navigation arrows

e Center: Patient, client, and capture information

e Bottom: Details about the currently displayed image

The lower toolbar contains a help button, image manipulation tools, and tools for image sharing.
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To open the upper toolbar:

> Drag the handle down.

To navigate through the images, do any of the following:
e Tap the thumbnails.

o Tap the left or right arrows.
e  Swipe left or right.

To use any tool:
e Tap the tool to open it.

o If a palette is displayed, tap a selection in the palette, and use any controls that become available.
e Tap the tool again to close it.

Important: While a tool is open, the application is in “tool mode.” You can perform only actions related
to that tool. You cannot use other tools or change images until you close the current tool.

Enhanced Image Viewer Tools
In the updated I-Vision Mobile application, you can now:

o Addtext, lines, arrows, and shapes to an image.
e Pan animage left or right.

e Flip an image horizontally or vertically.

o Rotate an image to any degree.

e Fit the image to the screen width.

To perform any of these functions, use the tools in the menu bar at the bottom of the screen or use the
corresponding touch-screen gestures. The tables below will help you get started.

IDEXX I-Vision Mobile Tools

Help Displays a text overlay that identifies each feature of the
? viewer.

Annotate Opens a palette of annotation tools. See “New Annotation

\
/ Tools” for more information.
f A
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Zoom

Displays zoom options. See “Improved Zoom” for more
information.

Window/level

Opens windowy/level controls to change contrast and
brightness.

Invert colors

Reverses colors in an image.

Flip Opens a palette of tools to flip images left/right and
horizontally or up/down, or rotate clockwise/counterclockwise.
vertically, or

rotate

Restore Restores image to its original state.

Share Displays a palette of tools for image sharing (email,

DICOM®, telemedicine).

Fit to screen

HHEE A=

Fits image to the width of the screen.

IDEXX I-Vision Mobile gestures

Zoom

Pinch fingers to zoom out. Spread fingers to zoom in.

Pan

1A

e

Drag left/right with one finger.

Window/level

Open window/level tool, then drag left/right to control
contrast. Drag up/down to control brightness.

Flip
horizontally or
vertically

Drag left/right with two fingers to flip image horizontally.
Drag up/down to flip image vertically.
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Rotate

Drag forefinger in a circle around thumb to rotate image.

Fit to screen i Double-tap to enlarge image to fill width of screen.

|

New Annotation Tools

To use the annotation tools:

1.
2.
3.

In the lower toolbar, tap the annotation tool to display the annotation palette.
Tap the tool you want.

Drag your finger on the image to apply the annotation. For text annotations, tap in the text box
displayed, and then use the on-screen keyboard to type your text.

Tap size and color formatting options.
Tip: If you make a mistake and want to start over, tap the garbage can icon to delete the annotation.

When ready, tap the annotation tool in the main toolbar to close the tool. Your annotations remain on
the image until you close the mobile application.

To change or delete an annotation:

1.

3.

Tap the annotation on the image to select it. (You must tap exactly on the line or text.) The
associated formatting or text palette opens.

To change the annotation, update the size, color, or text as needed. To delete the annotation, tap
the garbage can icon.

When finished, tap the annotation tool to close the tool.

Larger Images

A radiographic image now occupies the entire IDEXX I-Vision Mobile screen, giving you a better view.

Improved Zoom

Zoom tools have been improved to give you more control.

Tap the zoom tool and then change the image size any of these ways:

Tap a percentage.

Tap +/-to adjust image size in small increments. The actual percentage applied is shown in the
upper tab of the zoom options.

Drag the upper tab left or right.

Tap Fit to fit image to the width of the screen.

As always, you can use the pinch/spread gesture on the image to zoom out and in.

Additional improvements:

When you zoom, only the image changes size. The browser frame and buttons remain the same
size.
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e After a zoom, the image retains its new size until you change it.

e You can now apply window/level adjustments to a resized image.

Scanner Software Upgrade for the IDEXX I-Vision CR* System
A new version of the scanner software for the IDEXX I-Vision CR system is available if you are using the
Windows® 7 operating system. Contact IDEXX Digital Imaging Customer Support at 1-877-433-9948 for
more information or to upgrade. The following new features are part of this upgrade:

o Erase button—Erase an imaging cassette with a single click.

e Skip scanner interface—\When capturing radiographs, you no longer need to reselect the view on
the blue scanner interface window.
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Overview
In version 8.2 of the IDEXX Cornerstone* Practice Management System, IDEXX SmartLink* Digital
Imaging was enhanced to provide a more flexible image request work flow using the Image Request
special action feature. This made it easier to set up and maintain digital imaging invoice items.

Cornerstone 8.3 introduces Modality Worklist Integration, which offers a similar request workflow for
other, non-IDEXX imaging systems. This means that, in addition to requesting and receiving images
from IDEXX digital radiography systems, you can now create and manage image requests directly from
Cornerstone for non-IDEXX imaging systems that are compatible with the Modality Worklist functionality
of the DICOM® standard.

IDEXX supports modality worklist connections for systems where we have tested and validated the
connection with the system vendor or manufacturer. We maintain a list of systems that have been
validated by IDEXX as capable of integrating with Cornerstone. See idexx.com/validatedsystems for the
list of validated systems. There is a one-time fee for setting up the integration between a validated
system and Cornerstone. For more information, contact your IDEXX Cornerstone Sales Representative at
1-800-283-8386.

As with any integration between Cornerstone and non-IDEXX devices, the level of integration depends
on the capabilities of that non-IDEXX system. The table on the next page gives a general overview of the
work flow you will experience at different levels of integration.
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For all integration levels:
e The device is DICOM-compliant.
o The device supports the modality worklist feature of DICOM, either on its own or with additional software.

For basic integration: For partial integration: For high-level integration:
How the system uses The system does not automatically | The device auto-routes images to The device supports the DICOM
DicOM. send images to Cornerstone. You | comerstone. Modality Performed Procedure Step

may be able to use DICOM to

) i (MPPS) feature. The device can support
import images manually.

MPPS on its own or with the help of
additional software.

Can you send image Yes Yes Yes
requests from
Cornerstone to the
system?

Does Cornerstone Yes Yes Yes
capture charges
automatically for
requested images?

Does Cornerstone No No Yes
prompt you about billing
for images that weren't

requested?
How the image is The image is not displayed in the Cornerstone stores a copy of the The images are part of the medical
displayed and stored patient history or stored in image, and attaches it to the record automatically. The image is
Cornerstone unless you import it medical record. stored by the imaging system. When
manually. you view the image, Cornerstone
launches the imaging system software
to display the image.
Seeing request status in | Because the system isn't fully integrated, Cornerstone is not able to Completed requests are automatically
Cornerstone display whether or not the image request has been completed. This means | marked as completed

you'll need to manually mark requests as completed in Cornerstone after
you capture the images on the system.

Note: For information on purchasing the DICOM Imaging or Modality Worklist Integration, contact your IDEXX Cornerstone Sales Representative at
1-800-283-8386. If you have an IDEXX Digital Imaging system and already have SmartLink Digital Imaging, you do not need to purchase any
additional modules.
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Preparing for Integration
The checklist below will help you gather the information you need to have on hand in order to integrate
Cornerstone with a validated device. Most of these information requirements apply to all levels of
integration; those requirements that apply only to certain levels are marked.
About the validated device:
O Are DICOM features currently enabled on this device?
O Do you know how to change DICOM settings on this device?

O Do you have user documentation for this device, including the DICOM conformance statement?
Documentation may be printed or online.

O Do you know the model number of the device and the version number of any additional software
you use with the device?

O If you need additional software to support modality worklist features, have you installed that
software and does it support MPPS?

O

Do you have a customer support agreement for the validated device?

O For partial integration: Does the validated device automatically send images to Cornerstone as
it captures them? Or, if the device is not currently sending images automatically, can that
feature be set up?

About your computer network:
O Is the validated device connected to your practice’s computer network?

O Does the validated device use a Static IP address on your network? If not, can a Static IP
address be set up for the device?

O Does the device store images somewhere on the network other than on the device itself?
Examples might include a PACS system or an external hard drive.
About your copy of Cornerstone:
O Do you currently have DICOM Imaging or IDEXX-PACS software (or the previous Diagnostic
Imaging)?
O If you have an IDEXX Digital Radiography system, do you currently have SmartLink Digital
Imaging?
O Do you currently store images from this device in Cornerstone?
Work flow questions:

O Have you reviewed the work flow you will experience with this device and found it acceptable for
the way your practice works?

O For basic or partial integration: Is the work flow of manually marking requests as completed
acceptable for your practice?

Setup

New Option to Specify a DICOM Modality When Setting Up an Image Request Special
Action

You can set up a special action for an invoice item so that use of the item on the Patient Visit List (PVL)
or invoice automatically prompts Cornerstone to perform a certain action. With the new DICOM modality
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selection options in Cornerstone 8.3, you can select a specific modality to be associated with an invoice
item using the Image Request special action.

Note: To set up an invoice item to initiate an Image Request special action, image request functionality
must be activated.

You can set up the Image Request special action for an item on the Invoice Iltem Information window's
Spec. Actions tab. When you select the Image Request special action, a new Modality selection list is
available.

I® Invoice Item Information for Cardiac Ultrasound g@

|D: (1860 Cardiac Ultrasound O lrwentary (3) Service e

Infa Instructions Reminders Tan/Disc Link [terms Spec. Actions Travel ‘whiteboard

Special actions

Special action ‘when to apply ‘

Image Request v || Immediately on imvoice/PL] s | Modality: ™ Exam Desc:
= =

o o D3 Digital Radiography

US- Ulragound

You can select or change the modality at the time of use, if necessary. If you select a non-IDEXX
modality, in most cases you will want to indicate the exam you want by typing notes in the Exam
Description field.

These values default into an image request every time the special action is launched. You may also
leave the Modality and Exam Description fields blank.

Note: The Shot Selection B+ option is available only if an IDEXX-installed modality is selected.
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Option to Select a Modality When Creating a New Image Request
The New Image Request dialog box has been enhanced to include a new Modality selection list.

I® New Image Request for Casey { 15259 )

M=%

Patient information

-

Patient ID: (15259 Casey 11 ¥re. 1 Mos. 132 paunds
) FEL Mediumhair, Domestic  Spayed Female
Client. | Kimberly &dams | Reason for wisit:
Image Requests
Staff: | Schulze, D Corin [ C5] v
| Item 1D ‘ Deszcription | Amount | Center | Modality| | Exam Description
jSMHADS Small animal radiographs [3 views) $150.00H [ v 'E
ADENTXF Dental %-Raps - full mouth $0.00H v Full Mouth Dental Senes
$0.00 [v]

When creating the image request, you must specify a modality, and then do one of the following:

e If an IDEXX-installed modality is selected, you must either click the Shot Selection E+ icon and
select shots for the request or enter an exam description.
Note: If shots are not selected when the image request is created, then any shots captured during
the image capture session complete the request.

e If anon-IDEXX modality is selected, you must enter an exam description.

Note: The Shot Selection =+ icon is available only if an IDEXX-installed modality is selected.

Enhancements to the Image Requests and Results Window

The Image Requests and Results window is a central location where you can see the status of your
image requests. In Cornerstone 8.3, this window has been enhanced to provide the following new

features:

o New modality filter

e Modality type column in grid, allowing you to see what modality type was used on a request

o New request status filters for Started requests and Orphan results (available with high-level

integration):

o Started status—An image request that has been picked up by a non-IDEXX imaging unit.
Indicates that the job has been received by the unit but does not indicate whether any images

have been captured.

¢ Orphan status—An image exam that has been sent back from a non-IDEXX modality with a
patient ID that does not match a patient ID in Cornerstone.

Note: If your modality does not support MPPS, you do not have access to this feature.
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| o Image Requests and Results @
Date range Request status Other
Last modified:
. Requested  Clstated | (0o ol
3days (it [ Patial Clarhan
Completed Staff: | Al Stalf v]
Mot Requested
Paient Name Fatient D | Client Mame | Modality Exam Description | Status | Modiied
Casey 15259 Adams, Kimberly. [} Full Mouth Dental Series Fiequested 21472012
Casey 15259 Adams, Kirmberly. o Requested 2naniz Hew

Resolving Orphan or Not Requested Statuses for a Non-IDEXX Imaging Modality
Cornerstone 8.3 provides options for updating an imaging request with a status of Orphan or Not
Requested returned from a non-IDEXX imaging device. This feature is available with high-level
integration only.

Orphan Results

If an image request communication is sent back to Cornerstone and the patient or client information
does not exist in Cornerstone, the result is an Orphan.

To resolve an Orphan result from a non-IDEXX imaging modality:

1.  Onthe Image Requests and Results dialog box, select an Orphan image, and click Update.
2. Use the following fields/options on the Update Orphan Exam window help you to resolve the Orphan
exam result in Cornerstone:

e The Patient Information from Exam area displays information sent along with the Orphan result
from the non-IDEXX
; ; tem =10l x|
imaging system. Orphan

o The number Of \T’!:j'sz’lutlzulla[ilecrs:l‘;ﬁfzﬁﬁ:g?zl:; !‘;‘:jg:]:;g:ltlz: ﬁfa;nr::twéiq:r?él\efi\?vrlElliel:iage and image details. Cancel |
i Patient inf i
images and gapture e —
date are provided _

- . [=gl -
(helpful for billing if ,
your practlce bllls on % Bill this client £ Do nat bil this client
Number of Images: 2
. | = Captured Date: Dufgnmnnuu View"“agel
a per-shot basis).
| | Item D I Descriptian | Armnaunt | Center | Moda\ityl | Exam Description | Image: Deta\lsl

e [f you want to view
information that can help you to match the image to the correct patient in Cornerstone, click
Image Details. The DICOM header file information from the non-IDEXX imaging system
appears.

e If you need to look at the image to be able to decide whether you want to bill the client, and the
system used to capture the images either supports MPPS or automatically sends images to
Cornerstone, click View Image to open the Image Viewer.

3. If you determine the proper patient ID, enter the ID for the correct patient in the Patient ID text box.
4. To either bill or not bill for this image, select Do not bill this client or Bill this client.
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5. If you chose not to bill, continue with step 7.
6. If you chose to bill, do the following:
Select the invoice item ID that you want to use for billing.

If you need to change the ID, click the Invoice item ID field and press F2. The Invoice Item List
dialog box appears, and displays a list of all the imaging invoice items. You have several ways
to narrow down this list:

e If you want to filter the list by classification, click in the Classification text box and press F2.
Then select the classification that you use for radiographs, such as Radiography.

e If you want to filter the list by Item ID, click Item ID in the Search by area and then type the
ID in the Item ID text box.

e If you want to search by using words that are part of the description, click Description in the
Search by area and make sure that the Search for word check box is selected. Then type
part of the description in the Description text box and the list displays invoice items that
match.

e. Select the invoice item you want and click Select.
f.  Select the appropriate revenue center if it does not appear automatically. To see a list, click the
Revenue Center text box and press F2.

7. When you are finished, click OK to close the Not Requested Image for... dialog box, and then click
Close to close the Image Requests and Results window. The image is now listed as Completed (in
the Patient History area on the Patient Clipboard.)

Not Requested Results
If an image is captured for a patient that exists in Cornerstone but the image was not part of an image
request, the result is Not Requested. This feature is available with high-level integration only.
To resolve a Not Requested image:

I Not Requested Image for Maggie Mae {9030-1) [E=N o=
Not Requested

This image was caphured but not requested or billed,
You may edit the biling, staff and invoice item infarmation and view the image.
Cancel
Patient 1D: [3030-1 Maggie Mae s 0 Mos. 44 pounds @
CaM  Spaniel, English Springer  Spaped
Client:  Christopher V. Struebing E' Reason far visit:
Do ot kil this client pctroo

R Stucbing Chistopher V. V5] =] Captured Date:  05/23/2012

| ‘ Item 1D Description ‘ Armount | Center ‘ Mnda\ilyl | Eram Description
[1] $0.00 us % Misoelaneous

1. On the Image Requests and Results dialog box, select a Not Requested image, and click Update.
The Not Requested Image for... dialog box appears.

2. If you need to look at the image to be able to decide whether you want to bill the client for it, click
View to open the Image Viewer.
Note: The number of images and their capture dates are shown on the Not Requested Image for...
dialog box (helpful for billing if your practice bills on a per-shot basis).

3. If this image is not assigned to the proper patient, follow “To reassign image to proper patient and
resolve billing,” below.
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4. If you do not want to bill for this image, select Do not bill this client, and continue with step 6.
5. If you want to bill for this image:

a. Select Bill this client.

b. Select the invoice item ID that you want to use for billing.

c. Ifyou need to change the ID, click the Invoice item ID field and press F2. The Invoice Item List
dialog box appears, and displays a list of all the imaging invoice items from which you can
choose the appropriate ID.

6. When you are finished, click OK to close the Not Requested Image for... dialog box, and then click
Close to close the Image Requests and Results window. The image is now listed as Completed (in
the Patient History area on the Patient Clipboard.)

To reassign image to proper patient and resolve billing:
1. On the Image Requests and Results window, select Do not bill this client and click OK to exit.

2. On the Patient Clipboard, right-click the image in the Patient History area and select Image
Explorer.

On the Image Explorer window, select the image and click Reassign.
Reassign the image to the proper patient.
Close the Image Explorer.

View the proper patient on the Patient Clipboard.

N o o s~ w

Right-click the image in the Patient History area and select Image Requests and Results. On the
Image Requests and Results window, the image has a status of Not requested.

8. Follow the procedure above to bill or not bill for the Not requested image.

Manually Setting Requests to a Status of Completed
If the imaging device does not support MPPS (basic or partial integration), Cornerstone will not receive
information about the status of requests sent to that device. Because of this, the status for all requests
will continue to appear as Requested even after the image has been captured. Use the procedure below
to manually set the status to Complete so that you can filter the list on the Image Request and Results
window and see which requests really are complete.

To manually set a request to Completed:
» On the Imaging Requests and Results window, right-click the request and select Force Complete.

Note: You can only set pending requests to Complete. This feature is not available for Not Requested or
Orphan statuses—you need to deal with those results as described in the section above.

Image Request Special Action Item Report Filtered by Modality
The Image Request Special Action ltem Report has been updated in Cornerstone 8.3 to group invoice
items by modality. The report provides a listing of service-type invoice items, by modality type, that have
been set up to initiate the Image Request special action. Fields listed on the report include item ID,
invoice item description, amount, modality, exam description, and any preselected shots associated
with the item. This report is available in the Invoice Item report group.

e Sort options for the report include invoice item description, invoice item ID, and invoice item
modality.
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¢ Range options include invoice item description, invoice item ID and invoice item modality.

Image Request Special Action Iltem Report
Service Type Invoice Items with Image Request Special Action

Digital Radiography - DX

Item ID Invoice Item Description Amount Exam Description

12739 Radiographs (Thorax and Abdomen) $190.00 Thx-Abd

Selected Shots

DR 14x17 Head Left - Medium Animal (20 to 40Ibs) - Thorax - Thorax - R Lat
DR 14x17 Head Left - Medium Animal (20 to 40Ibs) - Abdomen - ABD - R Lat
DR 14x17 Head Left - Medium Animal (20 to 40lbs) - Thorax - Thorax - VD
DR 14x17 Head Left - Medium Animal (20 to 40lbs) - Abdomen - ABD - VD

Intra-oral Radiography - 10

ltem ID Invoice Item Description Amount Exam Description
5594 Dental Radigraph/ Large $20.91 Full mouth series
5592 Dental Radiograph/ Small $18.15 Full mouth series
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Solution

The IDEXX Cornerstone* Practice Management System integrated payment solution in Cornerstone 8.3
allows you to use a supported signature capture device or tablet PC to capture a client’s electronic
signature for all credit card payments. This helps you have fewer paper receipts to manage.

The IDEXX Cornerstone integrated payment solution, introduced in Cornerstone 8.1, offers a simple and
secure solution for credit card processing initiated from Cornerstone. The third-party payment
processing solution available in Cornerstone is XCharge®, developed by Accelerated Payment
Technologies™:

Accepts all major credit and debit cards in the United States and Canada.

Is Payment Card Industry (PCI) compliant.

Meets all Payment Application Data Security Standard (PA-DSS) requirements.
Accommodates many workstations but only requires one Internet connection.

Provides meaningful management reports.

Processes partial payments, which provides flexible payment options for improved revenue.

For detailed information on setting up and using the Cornerstone integrated payment solution with
XCharge, see the Cornerstone 8.3 Administrator’s Manual and the Cornerstone 8.3 User’s Manual.

Signature Capture Devices
Supported signature capture devices include the Topaz® ClipGem®, Topaz SignatureGem® (SigGem),
and Topaz SigLite® LCD devices, or a tablet PC.

For information on purchasing a signature capture device or tablet PC, call IDEXX Practice Solutions for
Supplies at 1-888-224-4408. If you have problems setting up your signature capture device, contact
Cornerstone Support at 1-800-695-2877.

Note: If a signature capture device will be used on a thin-client workstation, the device may need to be
connected to an AnywhereUSB® device, depending on the type of signature capture device being used.

Setup

Adding a Signature Capture Device in Cornerstone

As in previous versions of Cornerstone, the Signature Capture Device dialog box (Tools > Signature
Capture Device) allows you to select the capture device model to be used with Cornerstone. See the
Cornerstone Administrator’s Manual for further details. (This process has not changed in Cornerstone
8.3)
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™ Signature Capture Device

Select the model of the signature capture
device that is attached ta this workstation,

() ClipGem

) Mone

Erter port rumber: (0 (2]

[ Test Conmection ]

Cancel

Enabling the Electronic Signature Capture Feature

A new Enable Electronic signature capture check box on the Credit/Debit Payment Setup dialog box
allows you to enable the electronic card payment signature functionality. Update a card payment type

and click the Configure Payments Solution button).

[ o
¥as
Information Type
[#] &ctivate Credit Card Pavmert 5 I Credit/Debit Payment Setup
Cancel
Descriptiot: o
Promp: Pravider |#-Charge v
GL Account: Settings
See "GL Account Names" sectio
Merchant ID:
Carfigure Payrents Saolution
Receipt copies: | 114
Papment 5 olutions Enable Remember me for thiz session on login
Defaults Enable Electronic signsture capture
odes
- i (&3
Default amt from invaice: | |nvoice Ao %.Charge Setup
Diefault amt from Client Account: | Clisrt Balandg
I Ok l I Cancel ]

Note: Refer to the Cornerstone 8.3 Administrator's Manual and the Cornerstone 8.3 User’s Manual for
detailed information on XCharge setup and use with Cornerstone.

Use

Capturing the Client Signature at Payment Time
Staff can now capture a client’s authorization for a credit card payment when making a payment on their
client account or when posting an invoice.
Note: The signature capture box displays differently in Cornerstone depending on whether you are using
a signature capture device or a tablet PC. Also, Mobile Computing module users can capture signatures
in the field and process a payment.
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™ Payment for Jeff Ramsey for Invoice 16732
Client information
ID: 4627 Jeff Famzey

Payments

Credit code: Accept All Payments Previous balance due: $0.00
L yoice total: $68.00

I signature
M Payment Type J Status _]

T £5.00] Credi Card Papment [w

g oK,
= 000 [ g# ’%"“%’

Total:  $68.00
Mew payments: $68.00
Change given: $0.00
Balance after payments: $.00
Credit card signature on a signature capture device
™ Payment for Jeff Ramsey for Invoice 16732
Client information
1D: 4627 Jeff R amzey
Payments
Credit code: Accept All Payments Previous balance due: $0.00
Inwvoice total: $68.00
B Amount . F_'_‘_a_yn_w_e_rjt Tppe__ i Prompt Ainzwer | Deposit Date Status _]
gl E8.00| Credit Card Payment |v Card Mumber He BT 03/08/2012 49
= 0.00 [l 03/08/2012
Total:  $68.00
Accept New payments: $68.00
Change given: $0.00
Balance after payrnents: $.00
Credit Card Signature

Credit card signature on a tablet PC

Posting an Invoice—Option to Print a Full Invoice or Invoice Receipt
If you have enabled the Electronic Signature option in payment type setup and if Cornerstone detects a
capture device and/or tablet, then a drop-down list is available on the Post Invoice dialog box. This drop-
down list is activated when you select the Print Invoice check box, and it lets you specify if you want to
print the full invoice or an invoice receipt. A signature is printed on the invoice receipt, but it is not shown
on the full invoice.

Cornerstone 8.3 What’s New 80



Electronic Signature Capture with Integrated Payment Solution

™ Post Invoice

NOTE:

Mo other activity can be entered on this invaice once it has been posted.
Perform these tazks when posting
Apply payments

Print invoice

Posting date
Date: (03/23/2012 (4]

[ Frint special action documents

Invoice meszage

Thank pou for using our hospital for the care of your pets. We look forward to provide you
and your pet with quality service. Have a great day

Special action document list

i

Copies:| 1j#  Ful Invoice A
Check-out patisnts IFull Invc;\qce
rreoice Receipt
Apply papments to invoice for productrmproyrprow .

Meszage: | Thank You "

Identifying Signed Credit Card Transactions on the Patient Clipboard and the Client

Account

On the Patient Clipboard*, in the Client information area, the Account Information $ tab displays the
signature &4 icon for all credit card payments that have been electronically signed.

I® Head, Lynn - Patient Clipboard

Client
Clignt |D: [E553 Lynn Head

[Patient Balance Due  $0.00

Search| [715)851-7F615  [Home]

Client information

0SS EHeHNAR
Credit Code: Accept All Payments

Last Payment: 3618 on 03/29/2012
Credit Card Pavment

| [v]Hide voided items

Pet Owner
Accept All Payments

Total Patients: 1
Active Patients: 1

Date Tranzaction Description

|| 0342972012 Inwoice #: 16736 - Closed

: 03/23/2012 Payment: Credit Card Payment, Card Mumber: #:34<6781 on invaice 1672 &4 0.00

Current 000 |
30Day 0.00
B0 Day 0.00
90 Day 0.00
| Debit | Credit Balance
3618 0.00 3618
3618 0.00

The icon also displays to indicate electronically signed credit card payments on the Client Account

window.
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Changes to Payment on Account Report
The Payment on Account Report now includes a copy of the client signature for electronically signed
credit card payments.

I Print Preview
Selected tatal Page
[ pim [ sae || Do | 1o 1 161
Payment On Account "‘
Reprinted on: 3/2%2012
Lynn Head Client ID: 6559 o1
2427 W. 137th pl Wl
Eau Claire, W1 54703
WISA XXXXETS1 (59.50)
Change Given
Total (§9.50)
Signature:
X
BUYER AGREES TO PAY TOTAL AMOUNT ABOVE [v]
< i ]
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Overview

Version 8.3 of the IDEXX Cornerstone* Practice Management System offers specialists in all disciplines
a comprehensive solution for managing relationships with referring veterinarians (RDVMs). With these
new referral management features, specialists and their staff can easily monitor the pulse of all activity
relating to RDVMs and their patients.

New referral management features allow you to:

e |dentify patients/clients referred by a particular RDVM.

o Identify RDVMs associated with a particular patient.

e Identify RDVMs associated with a particular hospital.

¢ Quickly access notes about an RDVM’s education, interests, first referral date, etc.

¢ Document and view RDVM/hospital communication preferences.

e View RDVM and hospital communication preferences from the Patient Clipboard* window.

e Search for RDVMs/hospitals using common filters including name, city, phone, or fax number.

In addition, Cornerstone 8.3 features two new referral reports and enhancements to several existing
referral reports.

Use

Finding and Viewing Referral Veterinarian Information on the Doctor List

Using the enhanced Doctor List window (Lists > Referrals > Doctors), you can quickly find a referral
veterinarian (RDVM) using common search filters such as name, doctor ID, phone, or fax number.

X

™ Doctor List

Find an RDYM
Last name: |

Doctar 10 e

First name:

Hozpital:

[s]

Phone/Fax

[include inactives

RDYM

[ D

Buoston, Robert E.
Johnzon, Tim
Larson, Rich
Margan, Shane
Smith, John .

Update

Delete

Cloze

You can click the phone icon to access all personal and hospital-affiliated phone and fax numbers for
the RDVM within the Doctor List window. The primary contact number is indicated for both personal and

hospital numbers.
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™ RDVM Phone Information
Doctar: John M. Smith
ID: SMITH
Hospital ‘ Location ‘ Phone | Ext. | Frimary |
Personal (715] B78-9090 «
South Harvard Companion Animal Hospital (715) B74-5656 -

Adding, Editing, and Viewing Referral Veterinarian Information on the Doctor
Information Window

Hospitals Tab
The Doctor Information window’s Hospitals tab allows you to:

e Associate one or more hospitals with the RDVM (an RDVM must be associated with at least one
hospital).

e Add or edit the preferred contact phone numbers, email, and fax information for this doctor at a
selected hospital.

e Indicate the RDVM'’s communication preferences and contact information to use when at a selected
hospital.

Note: The Email communication preference will be selected automatically if the hospital’'s Send info via
field was set to Email prior to installing Cornerstone 8.3.

I® Doctor Information for Dr. Morgan g@

1D:* |SM

Title First* Ml Last®
|| Shane targan —

Status: | Active V Classification: V

Perzonal |nformation Hospitals | Patients | Sales | Motes

[1o] | Hospital City | State | Associatedl
CES Campbellville Equine Services Campbellville 3]
WwiRaH ‘whites Fioad Animal Hospital London 3]
Shane Morgan's contact inf tion at Campbellville Equine Services
Check to select communication preferences:

[ Letter: RR1

Postal Code: M1G 78 City: Camphbellvile StateProw: 0N
Ernail:
D Fax: [ -
[ phare: |Location Phane Extenzian |F'rimau,I | ]

&
' *

Personal Information Tab
The Doctor Information window’s Personal Information tab allows you to:

e Specify if you want to display the doctor’s contact information on the Patient Clipboard based on
Personal preferences (those selected on the Personal Information tab), Hospital related
preferences (those selected on the Hospitals tab), or both.
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e Add or edit personal contact information for this doctor.

¢ Indicate the doctor’s personal communication preferences.

Referral Relationship Management

Note: The Email communication preference will be selected automatically if the Send info via field was

set to Email prior to installing Cornerstone 8.3.

I Doctor Information for Dr. Morgan

ok

107 5
Title First* Ml Last®

: w Shane tMargan
Status: | Active ] Classification:

Personal Information | Hospital: | Patients | Sales | Notes

=

F | contact Inf tion

Dizplay the fallowing information on the Patient Clipboard:
[ Personal preferences Hozpital related preferences

Check to select communication preferences:

Cancel

[ Letter:
Posztal Code: City:
] Email:
CFa [ -
[ Phane: Location | Fhone | Estengion |Primar_l,l| 7
(1 - G|
Patients Tab

The Doctor Information window’s Patients tab allows you to:

e View checked in/checked out patients referred by the RDVM.

¢ Double-click to open the Patient Clipboard for a patient on this tab.

Cornerstone 8.3 What’s New
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I® Doctor Information for Dr. Larson g@

1D:* LARSOMN

Title First* Ml Last®

Dr. [l] Rich Larzon

Status: | Active [1] Classification: M

Persanal Information || Haspitals | Patients | Sales " Mates |

Checked-In
Fatient | LClient | Breed | Date | Hospital | Feason for Yisit

Boamer Andre, Larry Callie Mix 4/21/20010  Cleatiew Veterinary & Meuralogy

Sahara Kent, Jim Finzcher, Doberm BA7/20010 Clearview Veterinary £

Checked-Out Show patients checked-out in the last W days
Fatient | LClient | Breed | Last Seen | Hospital | Feason for Yisit

Sales Tab

The Doctor Information window’s Sales tab allows you to:

View the monthly sales generated based on referrals from this RDVM.

View number of new patient referrals and recheck referrals for each monthly sales period.

I® Doctor Information for Dr. Boston

BEX

D BULL
Title First* Ml Last®

br. [+ | [Robert E | |[Boston
Status: |Active M Classification: [i]
Personal Infarmation || Huospitals " Patients | Sales |N0tes |

End of Month Proceszing Date | Mew | Fechecks | Salez |

Curent 5 0 $155.00

‘wednesday, September 02, 2003 10:24 am 3 a $3197.56

Tuezday, June 30, 2009 02:41 pm 1 1] $552.39

Cornerstone 8.3 What’s New
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Notes Tab
The Doctor Information window’s Notes tab allows you to:
e Add, edit, or view notes associated with this RDVM.

e See the date of the first referral associated with this RDVM.

Referral Relationship Management

™ Doctor Information for Dr. Morgan

M=%

1D:* 5M
Title First* Ml Last*
[ Shane Morgan
Status: | Active ™M Classification: v

Perzonal Information Hospitals Patients Sales | Motes

First refemral: B/15/2010
University:

Interests:

Motes:

Cancel

Finding and Viewing Referral Hospital Information on the Hospital List
Using the enhanced Hospital List window (Lists > Referrals > Hospitals), you can quickly find a
referral hospital using common search filters, such as city, phone, or fax number.

I® Hospital List
Hospital: [include inactives
City:
Phone/Fax:
Hospital Mame | 1D | City | State | Mew
Burgess Equine Vet Services BEWS Qrillia oM \
Campbellvile Equine Services CES Campbellvile oM \
Clearyiew Veterinary Services 38443 Longiew IL \
i i i Delete
Kitchener Cat Hozpital KCH Kitchener oM \
Mizsizzauga-0akville Emergency MOES Oakville oM \
South Harvard Compation Animal Hospi SPEC Eau Claire W 5
‘wihites Road Animal Hospital WwhHAH London OM ™~ | Cloze

South Harvard Companion Animal Hospital
3344 South Paw Way
Eau Clairz, /| 54701

Phane: (715] 674-5656
Faw: [661) 835-7403

When you highlight a hospital on the Hospital List, the hospital’s address, phone, and fax information

display at the bottom of the window.

Adding, Editing, and Viewing Referral Hospital Information on the Hospital

Information Window

Information Tab

The Hospital Information window’s Information tab allows you to:

Cornerstone 8.3 What’s New
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Add or edit contact information for this hospital.

Indicate the hospital’s communication preferences.

I Hospital Information for South Harvard C

panion Animal H

ID:* |SPEC

Hospital Mame:* [South Harvard Companion &rimal Hospital

Information | Doctors

Patients | Sales | Motes

Contact information
Check to select communication preferences:

[] Letter: (3344 South Paw wWay

Postal Code: 54701 City: E au Claire

Email:
[ Fax:

[ Phane:

customerresponse@idexs. com

[E61) 885-7403

Location

Status: | Active [v]

p M=)

ak

Cancel

State/Prov: Wl v

| Phane

Extenzion

[715) E74-5656
[y -

|F'r|mary | 7
& Ed
s £

Doctors Tab

The Hospital Information window’s Doctors tab allows you to:

View referral veterinarians (RDVMs) associated with this hospital.

I® Hospital Information for South Harvard Companion 4nimal Hospit

p

1D:* SPEC

Hospital Mame:* |South Harvard Companion &nimal Hospital Status: | Active

=1 %]

ok

.v.

Informaticn Doctors | Patients || Sales | Motes
Classification: Al v
[} RD%M Classification
BULL Boston, Fobert E
SMITH Smith, John b
Dr.Robert E. Boston igw details

Cornerstone 8.3 What’s New
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Open the Doctor Information window for a doctor by double-clicking a listed RDVM (or by clicking
the View details link near the bottom of the window for a selected RDVM).
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Patients Tab

The Hospital Information window’s Patients tab allows you to:

I Hospital Information for ClearView Veterinary Services E]@
T
Hospital Mame:* Clearyiew Yeterinary Services Status: | Active (]
Information || Doctors | Patients | Sales | Motes
Checked-In
Patient | Client | Ereed | Date | RO | Feason for Visit |
Boomer Andre, Lany Calie Mix 44212010 Larsan, Rich Meurology
Sahara Kent, Jim Pinzcher, Doberm 6417/2000 Larson, Rich
Checked-Out Show patients checked-out in the last W days
Patignt | Client Ereed Lazt Seen RDYM Reazon for Yisit |
Sales Tab

The Hospital Information window’s Sales tab allows you to:

View the monthly sales generated based on referrals from this hospital.

I Hospital Information for South Harvard C

panion Animal Hospital

M=%

ID:* SPEC

Hospital Mame:* S outh Harvard Companion Animal Hospital Statuz: | Active

]

Infarmation Doctors | Patients | Sales | Motes

End of Month Processing Date | Mew | Rechecks | Sales |
Curent B 1] $256.50
Thurzday, October 07, 2003 05340 am 4 ] $3.24954
‘wednesday, September 02, 2009 10:24 am 3 1] $4.340.71
Tuesday, June 30, 2009 02:41 pm 7 ] $9515.48

Cornerstone 8.3 What’s New

Referral Relationship Management

View checked in/checked out patients referred by an RDVM at this hospital.
Double-click to open the Patient Clipboard for a patient on this tab.

View number of new patient referrals and recheck referrals for each monthly sales period.
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Notes Tab
The Hospital Information window’s Notes tab allows you to:

Add, edit, or view notes associated with the referral hospital.

See the date of the first referral associated with this hospital.

I Hospital Information for Mississauga-Oakville Emergency E]@
10 WoES
Hospital Mame:* Missiszauga-Oakvile Emergency Status: |Active 2

Information Doctors || Patients | Sales | Notes

First refemal:
Motes
Clinic hours are 7a-7p M-Sat. Open il 9:00 an Thurs. Clozed on Sun

Accessing Referral Information and Referral History in Patient Information
The Patient Information window’s Referrals tab has been enhanced to serve as a dual-purpose tab,
allowing you to view both referral veterinarians (RDVM) and hospitals for a patient and the referral history
of that patient.

You should verify the RDVM information for a patient for each visit or case and update it as necessary.

Referrals Tab—Patient RDVMs View
The Referrals tab—Patient RDVMs view allows you to:

Identify RDVMs associated with this patient for this visit.

Specify a primary RDVM to be associated with this patient on the Patient Clipboard, in referral
history, and on referral revenue reports.

Specify if an RDVM should be included on communications associated with this visit (using the This
visit check box). The This visit check box is automatically selected for the primary RDVM, but you
can clear the check box if the client has requested that the primary RDVM not receive
communications. For more information about communications and an example using RDVMs, see
“Emailing or Faxing Documents from the Cornerstone Editor” on page 20.

View communication preferences for a selected RDVM and hospital and associated contact
information.

View the RDVM history for the patient.

Note: When viewing the Referrals tab in Referral History view, click the view RDVMs for this patient link
to switch the tab to Patient RDVMs view.
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I patient Information for Boomer E]@

1D: [15245 Baomer “
Owners: Lamy Andre

Infarmation Letter Reminders Call Backs Prampts/Motes Relenals Paticnt File
Refemal information for Boomer

Identify doctors for this patient. wiewt refenal history

The primary doctor shows on the Patient Clipboard, referral history and revenue reports.

Doctar Hospital Primary | This visit | Diagnasis
| ]

~ - 0
Larson, Rich Clearyizw Yeterinary Services &

Images

Personal view details ~
Send info via: email

v

When an RDVM is selected, the associated communication preferences are listed in the box at the
bottom of the tab. Use the scrollbar on the right side of the box to scroll through the available
communication preferences:

e Personal—Displays the RDVM’s personal communication preferences. If you want to view detailed
personal contact information for this RDVM, click the view details link on the right to display the
information on the Doctor Information window’s Personal Information tab.

e When at [hospital name]—Displays the RDVM’s communication preferences when at the hospital
selected above. If you want to view detailed hospital contact information for this RDVM, click the
view details link on the right to display the information on the Hospitals tab in the Doctor
Information window.

o Hospital: [hospital name]—Displays the selected hospital’s communication preferences. If you
want to view detailed contact information for this hospital, click the view details link on the right to
display the information on the Information tab in the Hospital Information window.

Referrals Tab-Referral History View
The Referrals tab—Referral History view allows you to:

e View complete referral history for this patient, including the date when the primary RDVM/hospital
was assigned to this patient.

Note: When viewing the Referrals tab in Patient RDVMs view, click the view referral history link to
switch the tab to Patient History view.
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I patient Information for Boomer

=JEEs

10: 15245

S

Information

Owners: Lamy Andre

Referral history

Letter Reminders

Boomer

Call Backs Prampts/Mates Refemals

view ROVWMs for this patient

Date

Doctar Hospital

0K

Cancel

tient File

Prescriptions

Dizgnosis

[
| 1 #2100

Larson, Rich

Clearview Veterinary Services

ARl

Images

Accessing Referral Information on the Patient Clipboard* Window

Patient Information

In addition to an updated layout to accommodate quick “at a glance” scanning, the Patient information
area now includes information on the patient’s primary referral veterinarian (RDVM), the RDVM primary

phone number, and a link to view more RDVMs for this patient (or a link to add an RDVM if one has not
been assigned for this patient).

I Andre, Larry - Patient Clipboard

B[=1%]

Client information

Larmy Andre
35635 Oak

Eau Claire, Wi
54703

Summary | Teut

Prablerns D

O 08| R w0 N e E

Client Patient list

Client |D: 8973 Lary Andre Pet Owner Mame | Species | EBreed | Sex |
Patient| Balance Due $0.00 Accept All Papments Total Patients: 1 EBioomer Canine Collie Mix Meutered Mah
Search| [715) 2834433

Aclive Patients: 1

Patient information

Status: Active Boomer [15245]

513, 9 Mos.[4/21/2008)
CaN Collie Mix
Color: Bigcuit

Class: Pet Owner

Refemed: 0 clients

Status: Active
Ward: Treatment Area 1
ROWM: Rich Larson

Home Practice: 1 more RDVMs

@lals v @& B E S %

Inpatient

45 pounds
Meutered Male
Markings:

Class: Family Pet
Cage:
ROV Phone: [715) 556-8339

Rx | Medical Hotes Lab | Vital Sighs Full Size Yiew
Date | Staff | History
4/z1/2mo B 45.00 pounds
a/z172m0 (3] KH Possible Brain Tumor  Practice: 1
4215200 g LP Seizure Woarkup- Neurology - TENTATIVE - Seizure Workup
47215200 LF 1.00 Examination- Seizure [SEIZ) for $48.00
RDVMs Tab

The Patient Clipboard Referrals tab in the Patient information area has been renamed the RDVMs
(Referral Veterinarians) tab in Cornerstone 8.3. Click the RDVMSs button §& to access the tab. If you
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upgraded to Comerstone 8.3 from an earlier version of Cornerstone, the most recent RDVM is listed as

the primary RDVM for each patient.

e The RDVMs tab lists the patient’s current RDVMs and their associated hospitals.

o The RDVMs tab right-click menu provides quick access to detailed referral information and contacts

for this patient.

~
I® andre, Larry - Patient Clipboard g@
Client Patient list
Client ID: 8373 Lary &ndie Pet Owner Name | Species Bireed | Sex |
Patiert | Balance Dug $0.00 Accept Al Payments Total Patients: 1 Boomer Canine Caolie Mix Neutered Mah
Search| [/15]283-4433 Active Patients: 1
Client information Patient information
oS E 80N AR @A %Y E 886D %
Larry Andre Status: Active Current R0z Haozpital | |
35635 Dak Class: Pt Dwner Larson, Rich Cleartiew Veterinary Services Undate Paient
B Referred: O clients Update Hospital
au Claire, 5 N 5 ) . p Update RDYM
Hospital: CleaiView Yeterinary Services wiew details N .
54703
Send info via: emal Wiew all Patient RDYMs
View Referral History
Home Practice: 1 Uv
Summary |Tekt || Prablerns || Dx || Rx ” Medical Mates " Lab " Wital Signs Full Size View

Date I | Staff I Histary
44212010 m 45.00 pounds
4/21/2Mm0 jj KH Fossible Brain Tumor  Practice: 1
4/21/2010 _@] LP Seizure Warkup- Neuralogy - TENTATIE - Seizure ‘Warkup

When an RDVM is selected on this tab, the associated communication preferences are listed in the box

at the bottom of the tab.

e Use the scrollbar on the right side of the box to scroll through the available communication

preferences.

e Click the view details link to access detailed contact information.

Note: The communication preferences that display here vary depending on the Patient Clipboard
display preferences selected for the RDVM on the Personal Information tab in the Doctor Information

window.

@%¥|E]a[3]@E AR 0] 6 [€—— RDVMSs tab

Current RDhs
Bostan, Robert

Hospital

Double-click to access Patient Info - Referrals tab

¥Yhen at South Harvard Companion Animal Hospital
Mo communication preferences selected

Click to view RVDM details

South Harvard Companion Animal Hospital

view details

[m| »

@R e EEA RS 6

Barkzalot (G632
Bre 4 Moz 1141942003 41 pounds 3
Meutered Male

Can Retriever, Galden

Color: Gold Markings:

Statuz Active Clazz: Family Pet

ward: Cage:

ROWH: Robert Boston RO%M Phone: [715) 983-0303

view communication log

mare RDYis
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EEIEEDEIEEEDERE]

Current ROz

Boston, Robert

South Harvard Como

¥When at South Harvard Companion Animal Hospita
Mo communication preferences selected

New right-click options

Hospital

Aninn Animal Hosnital

Update Patient
Update Hospital
Update RDVM

View all Patient RDVMSs
View Referral History

assign RDVMs.

Referral Information on the Patient Check-in/out Window
New options added to the Patient Check-in/out window Cornerstone 8.3 make it easy to identify and

On the Patient Check-in/out window, if a primary RDVM has been assigned for this patient, the RDVM is

listed. In addition, the add/edit RDVMs link opens the Patient Information window’s Referral tab,

allowing you to:

e Add anew RDVM for this patient.

e Access information for an existing RDVM.

e Specify a primary RDVM for the visit by selecting the Primary option.

e Specify the RDVMs you want to receive communications associated with this visit by
selecting/clearing the This visit check box for each listed RDVM. The RDVM must have

communication preferences set up in Cornerstone for the information to automatically appear in the

Communications window.

Check-in Date: | 01/25/2010 54 Time: | 0210 AM

™ patient Check-infout Q =
Client information Accounts receivable
Client ID: 8973 Larry Andre Current: $0.00
3553 5 Oak 30 days: $0.00
Eau Claire, '/ 54703 B0 days: $0.00
Phone(s]: | (715) 253-4433 Est: 50 days: $0.00 Trawel Shest
Total due: $0.00
Patient information Heminders
ID: 15245 Boomer
45 pounds Colie Mix
Brs 9 Moz, Meutered b ale
Check-infout information
Staff 1D: kH Kenneth G. Boffke, D Room: | Dr Boffke [+] O Outpatient
RDWM: Rich Larson addfedit RDVMs Ward: | Treatment Area | [v] @ lnpatient
Rieasan for Visit Refenal Recheck oce
Prneny NEWSEEII | s (reatent [v] Dl
Secondany: [i] Documents
Additional notes: |D0c: |D| Description |
Possible Brain Tumor |
3
3
Alert n?tes: . Weight entiy
May bite - somewhat dizoriented Date I Weight I Unit I el e I

01/27/2012 (4

Check-gut Date:

00 pounds [ v [w]

/27/2012 (&) Time: | 1245 PM
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Referral Information for Mobile Computing
RDVM information is enabled and viewable via hyperlinks for Mobile Computing module users. Click the
links to open a read-only view of the Patient Information > RDVMs tab. There are also two new options
available when you right-click in the Patient Information > RDVMs tab (View all Patient RDVMs and

View Referral History).

New and Enhanced Referral Reports
New Reports

EOM Referral Revenue Report by Doctor by Revenue Center

by Revenue Genter

Referral Revenue Report by Doctor

Monday, March 31, 2008 12:48 pm through Friday, December 16, 2011 01:47 pm

Ref Doctor Rev Center  Client 1D Marme MNew  Rechecks  Tolal Visils Bales

Borshwim, Krisiti
0% Frontage Road MW

Eau Claire Wl s4T03

. Haspial

I Uavid Allsic 1 0 1 $1.004.64
Total for Revenue Center H - Mosphal: 1 [ 1 $1.004.04
L - Labaeatary

735 Dinvid Affaio 1 a 1 S575 04
Tatnl for Revvenur Conter | - Labamtary: 1 a 1 E6TA 04
LS - Lt Surgery

T35 David Allaho 1 0 1 §1.526.16
Tokal for Revenug Contir LS - Laser Surgary. 1 L] 1 F1.526.16
P Pharmacy

T3 Daved Alfaic 1 0 1 501 32
Total fr Rgvenue Conter P - Phasmasy: 1 L] 1 £601.32
P3 - Prolessional Services

735 Dinvid Affalo 1 a 1 £796 08
Tatnl for Revenue Conter PS - Professionnl Services: 1 a 1 70608
3 - Surgery

T3 David Allsio 1 0 1 57.790.88
Total for Ravenug Contir S - Surgany 1 ] 1 $7.790.88
Taotal for Krisiti Borsheim: L] L] L] 1232412

EOM Referral Revenue Report by Hospital by Revenue Center

by Revenue Center

Referral Revenue Report by Hospital

Wednesday, April 30, 2008 07:06 am through Friday, December 16, 2011 01:47 pm

Ref Hospital Rev Center Client ID Name New Rechecks Total Visits Sales
Byron Pet Clinic
855 Frontage Road NW
Eau Claire Wi 54703
H - Hospilal
7395 David Affalo 1 0 1 $86.22
Total for Revenue Center H - Hospital: 1 o 1 $686.22
L - Labaralory
7395 Danid Affalo 1 0 1 $47.92
Total for Revenue Center L - Laboratory: 1 a 1 $47.92
LS - Laser Surgery
7395 David Affalo 1 0 1 §127.18
Total for Revenue Cenler LS - Laser Surgery: 1 4 1 $127.18
P - Pharmacy
7395 David Affalo 1 0 1 $50.11
Total for Revenue Cenler P - Pharmacy: 1 a 1 §50.11
PS - Professional Services
7395 David Affalo 1 0 1 66,34
Total for Revenue Center PS - Professional Senvices: 1 [ 1 566.34
S - Surgery
7395 David Affalo 1 0 1 $649.24
Tatal for Revenue Center S - Surgery: 1 o 1 $649.24
Total for Byron Pet Clinic: L] 0 6 $1,027.01

Referral Relationship Management

These new referral reports display the work done by a staff member of your practice for a referring

doctor/hospital.
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Report fields include:

Referral Doctor/Hospital
Revenue Center Client ID
[Client] Name

New—Total number of invoices with referral patients where the patient was not checked in using the
referral recheck option.

Rechecks—Total number of invoices with referral patients where the patient was checked in using
the referral recheck option.

Total Visits—Total number of invoices for both new and recheck visits.
Sales—Total net sales for client’s referral patients.

Total for Revenue Center—Sums for new visits, recheck visits, total visits and sales for each revenue
center.

Total for Doctor—Sums for new visits, recheck visits, total visits and sales for each referring
doctor/hospital.

Extra fields included when saving to a file—Patient ID, Invoice ID, and Practice

Enhanced Reports

New ranges are available for existing End of Month referral reports:

Referral Revenue Report by Revenue Center by Doctor by Hospital
Referral Revenue Report by Revenue Center by Hospital by Doctor
Referral Summary by Revenue Center—Doctor by Hospital
Referral Summary by Revenue Center—Hospital by Doctor
Referral Doctor Master Report

Referral Hospital Master Report

Enhancements have been made to several existing referral reports:

Referral Summary by Doctor
Referral Summary by Hospital

Referral Report by Staff
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Inventory

Enhancements to Cornerstone* Inventory Windows

Electronic Inventory Ordering with IDEXX SmartOrder* and MWI® Veterinary
Supply
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Enhancements to Cornerstone®

Inventory Windows

Many of the main IDEXX Cornerstone* Practice Management System Inventory windows have been
updated with a new look and feel, including new labels and text, so that you can more quickly and easily
navigate them. In addition, the updated windows include new sort options and new show/hide column
settings for displaying invoice item grids.

Notes:

e The inventory windows require that Windows® Internet Explorer® 7 or later be installed on each
workstation. It does not have to be used as the default Internet browser.

e If you use the Mobile Computing module, your main Cornerstone Inventory windows will look
unchanged.

Use

Want List
To access the Want List, on the menu bar, select Inventory > Want List or click the Want List button

on the Cornerstone toolbar.

I want List Q@
Add items to the Want List Ok
Inventory tem Cancel

ftem ID: 107 QHC‘;’E Cenine Hepatic L514 17.5Lobs
Quantity: S bag = 500 bag
Reason:
Location: [All Locations -

Group: |All Groups v

|:| Not an inventory tem

In Cornerstone 8.3, the Want List has been reorganized to make it easier to distinguish between
inventory and non-inventory items. When adding an item to the Want List, you must specify if the item is
an inventory item with an existing item ID or without an ID in Cornerstone.

o If the want item is an inventory item, leave the Inventory item check box selected and type the item

ID in the Item ID text box or press F2 (or click @.) to search for and select the ID from the Search
for Inventory ltem dialog box (see “Search for Inventory ltem” on page 103 for more information).
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o If the want item is not an inventory item, select the Not an inventory item check box and type a

Enhancements to Cornerstone* Inventory Windows

description. The item will appear on the Want List without an item ID.

Purchasing Work List

The Purchasing Work List window has been updated with several improvements to fields, on-screen text,
and grid navigation/display options.

To access the Purchasing Work List, on the menu bar, select Inventory > Purchasing Work List.

§
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Single Location Inventory

urchasing Work Lis!

i om s o
mlimen [T
CToN (]
e i e
I T |
ORI e
o om0 "
T [
113 e 48 [
LT T -t

Items to consider ordering

Suggested tem

‘Wanﬂsuggesled List " Lecate An ftem || Quantity at Location |

jéant liem add to Want List

CvP VD Caning Wenisan Potato canned 8.00 caze | Mot Done

CWD10 |Canine wid 10 Ib

2.00 bag Hot Done

CWD20 | Canine wid 20 Ib

3.00(bag  |Mot Done

CZDU1& |Canine z/d uftra 18lp

1.00 bag Mot Done

ECLR1S |lams Canine Low Residue 151, 3.00(bag  |Mot Done

ECLR30 |lams Low Residue 20 Ib.

2.00 bag Not Done

ECLRPS | lams Low Residus Fuppy 8h. 100 bag  [MotDone

FCD10 |Felne cid 10 1b

2.00 bag Not Done

FCD4  |Felnecid41b

400/bag  |Mot Done

FCDS20 |Feline c/id 20 Ib

2.00 bag Not Done

FOM Feline DM can

28.00 case | Mot Done

FLD4 Feline LD 4ib.

1.00 bag Not Done

FMD4  |Feline mid 4ib.

1.00/bag  |Mot Dene

Search results 1 to 25 of 36

4 4> M

Results per page | 2

Groups: Location (Applies to Want List Only): Status:
|21 Grouss [¥| [ArLocatens [v]  |aisauses [ | [Restore columns |
Type | D A Description Qty UOM | Status | Vender

Item Details

Caning cid 10 16

¥ Location " Groups
[ o] [eoen v
Stocking Levels: sales History
Qty On Hand:

1
Qty On Order 0
Qty On Back Order: 0
Qty On Unsent Order: 0
Qty OnPYL Order
(Uncenfirmed):

Today's Reorder Point
Rearder Point

Rearder Qty

Over Stock Point

Add To Order
Canine c/d 10 I
Order Quantity  Unit OF Measure:
Ea—

vendor”
Totel cost of selected items: ¢ .o [ e
(Based on last cost of item) : - Group:
AllGroups v
|* More Item Informietion For Canine c/d 10 Ib J Notes:

o]

Multi-Location Inventory
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Major updates to the Purchasing Work List window include:
e Added a new add to Want List link that opens the Want List dialog box.

¢ Replaced the Want List icon that displays in the left-most column on the grid next to an item if the
item came from the Want List. The [&]icon matches the Want List button on the Cornerstone
toolbar.

e Enhanced the invoice item grid navigation, display, and sort options (see “New Invoice ltem Grid
Sort and Display Options” on page 105 for information).
¢ Renamed the Delete button; it is now the Remove From List button.

e Changed the way you expand/collapse the item information tabs available at the bottom of the
Purchasing Work List window. Click the new More Item Information For bar to switch between
showing and hiding the item information tabs.

Purchase Order List
The Order List window has been updated with several improvements to fields, on-screen text, and grid
navigation/display options.

To access the Purchase Order List, on the menu bar, select Inventory > Order List.

Lwtomentone SEIE)
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Major updates to the Purchase Order List window include:

e Enhanced the invoice item grid navigation, display and sort options (see “New Invoice ltem Grid Sort
and Display Options” on page 105 for information).

¢ Renamed the Receive Now button; it is now the Receive Order button.
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Create Purchase Order
The Add a New Purchase Order window has been renamed the Create Purchase Order window. It has
been updated with several improvements to fields, on-screen text, and grid display options.

To access the Create Purchase Order window, select Add New Order on the Order List window or click
Add to add selected item(s) to an order from the Purchasing Work List.

T PETES

GoepsvIIAsEN. EnATDOEYE: i
[remrmeoeer

Create a Purchace Order for & spacific vendor

Verdar * Group
Fodl Veternary Suzsy

<] Deacrgtion Gty wom 58 Cont Sty Order oy Notes | Sp Track Cancel
102 Leoto Titer ot KSU 000 Inonel Mo 00 Ordesed Sone. VM. Cesey 7 | |

Total Cost 3000 Remave From Onder

o informanon for Lepto Tier at KSU

Major updates to the Create Purchase Order window include:
e Added additional on-screen tip text that displays on the right side of the window.

e Enhanced the invoice item grid navigation, display, and sort options (see “New Invoice Item Grid
Sort and Display Options” on page 105 for information).

e Replaced the Notes icon that displays in the right-most column on the grid with a new icon: ﬁ
e (Changed Total value label to Total cost (displays below invoice item grid).

¢ Replaced the Back button with a Cancel button and replaced the Delete button with a Remove from
Order button (displays below the invoice item grid, next to the total cost).

e Made changes to the item information area that you can show/hide at the bottom of the window (see
“Item Information Tabs” below for information).

e Included fulfillment and support information when placing orders online through IDEXX SmartOrder*
with MWI Veterinary Supply.

Item Information Tabs
As in earlier versions of Cornerstone, a group of expandable tabs provides information for inventory
items marked Maintain Quantity on Hand (QOH). The tabs are available at the bottom of many
Cornerstone Inventory windows.
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In Cornerstone 8.3, the method used to show/hide the tabs has changed. To switch between
showing/hiding the tabs on an applicable Cornerstone Inventory window, click the More ltem
Information For [item description] or Information bar to view/hide item information tabs for the

selected invoice item.

O More Itemn Information For lams Low Residue Puppy 8lb.

tem Hiztory | Item Information || Stock Locations

Stocked at: NIA

Total QoH: 4.00 Base price: 32421 Buy UOM: bag

On order: 0 Minimum price: $0.00 Sell UOM: bag
On back order; 0 Dizpenzing fee: 50.00 Buy/=zell ratio: 1

Lazt cost: 318.20 Markup: 33 Primary wendaor:

Updates to the More Item Information or Information tab include:

» Improved the item statuses displayed in the ltem History tab. The Transaction column provides
detailed information on the order status of the selected invoice item.

|v More Item Information For Cerenia 24mg pack of 4

iHem History || tem information | Stock Lecations

Date v Transaction From To Quantity UOM

0712472012 Ordered 1.00 | [Nene]
0882012 Ordered 20.00 |[None]
osHT2012 Ordered 2.00 |[None]

Search results 110 3 of 3

Search for Inventory Item

Unit Cost
$15.87|
30.00
£0.00

Q

Total Cost  Vendor
$15.87 MW
S0.00 MW Veterinary !
%0.00/ ANTECH-PM PICI

Results per page ;| 25 w

When accessed from the Want List, Create Purchase Order, or Purchasing Work List windows, the
Search for Inventory ltem dialog box appears in an enhanced display and includes new filtering options.
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Search lor Inventory am 3

Find an inventory item Reset

Vendor |40 Wendors

<

Classdication: Al Classifications »

[Ciescription | @ bemiD " Vendor tem D
Search for o word Include mactive nventory tems
04 ‘Vendor VendorfemiD Descripiion Classificabon Price Selact
1o ke 28519 Metronidazole injectabie bag Injeciablss 53500
| 102 Lepio Ther ot KSU Lab 54350
103 e foosi Cerenia 2dmg pack of 4 Pharmacy S1E.00
104 | Cernnia 60 mg pack of 4 Pharmacy §24.50
AE 107 U 130081 RCWD Canina Hepatic L514 17.50b8 Diet 33865
o |08 |HLLS Canine 210 Ura 27 SLbs Science Diet 57512
10on 10% Dexirose Sowdion Injeciables 30.00
& (152 | Vietmedin § mg Botile of 50 Pharmacy 885,00
114 Dwg Day Boarding Hosplalization 750
[ 15 .I.' W 100118 Dexasone / Bendaryl Injeciions Injeciables .333 50
18 Daog Boarding Boarding 20.00
[ iz A 10012 CET 2% chiprhexiding ringe Pharmacy -$i5 el
_& 123 ke 10055 IDEXK Phencharbiial Lab 2073
_& 135 [ MDD Feine Rabbié and Green Pea #8lb Dot $ETI 3
Search resutis 1 to 25 of 733 M A M Resubs per page |25 |+

Major updates to the Search for Inventory Item dialog box include:
e Added Vendor and Vendor Item ID fields.

e Added a Search for a word check box and removed the Keyword filter in the advanced search
options.

e (Changed Item ID filter to suggest search matches as you type; matches include all IDs that contain
the typed ID characters in the given order.

e Removed Advanced search button (advanced search options are permanently included on the
dialog box).

e Added Search vendor item IDs (only) check box, which filters your invoice item search based on
vendor item IDs.

e Added a Reset button, which restores the default search filter settings.

e Enhanced the invoice item grid navigation, display, and sort options (see “New Invoice Item Grid
Sort and Display Options” below for information).

e Added navigation buttons (at bottom of invoice item grid). Click the First arrow button to display the
first page of invoice items, the Previous and Next arrow buttons to move to the previous or next
page of items, and the Last arrow button to move to the very last page of items.

e If you want to change the number of items displayed on each page, select an option from the
Results per page drop-down list (bottom right).

e Replaced the grid’s Quantity on Hand icon from the previous flag icon to o , indicating that
quantity on hand is tracked for the item.

e The method used to show/hide the Add an item area has changed. To switch between
showing/hiding these fields, click the Add an Item bar. This is a new feature for Single Location
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Inventory users. Tip: The % character can be used in the Description field as a wildcard character
to enhance searching by adding it before or after a word.

New Invoice Item Grid Sort and Display Options
Many Cornerstone Inventory windows updated in Cornerstone 8.3 feature a new invoice item grid that
provides enhanced sort and display settings (selected columns, column order, sort order, etc.) that you
can change based on your preferences for viewing the information.

To rearrange columns within a table: Dv  UON | AdiedEoae | Suhs | Vender
» Click and drag a column header (column name) to the left or o —

right to move it to the desired location within all currently H emewor  |ejer
displayed columns. R ', .

To change the table sort order: ol

1. If you want to change the order in which information is displayed in 1.

a table, click the name of the column by which you would like to sort the i et

table. A small triangle displays to the right of the column name to o

indicate the column used for the current sort order. v com

2. Click the same column header again to reverse the sorting order.

Note: You can also right-click a column header and select Sort
Ascending or Sort Descending to set the sort order for a table. The Search for Inventory Item dialog
box contains a subset of the search options that are listed in the right-click menu.

To change the table display using the right-click menu options:
Right-click a column header and select one of the following menu options:

e Columns (allows you to select/deselect columns to display in the table)
o  Group by [column header]

e Freeze/Unfreeze [column header]
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Inventory Solution and MWI® Veterinary Supply

New IDEXX SmartOrder* electronic inventory ordering in Cornerstone* 8.3 allows for a more efficient
inventory work flow with real-time online inventory ordering through MWI® Veterinary Supply. Two of the
industry’s leading systems, Cornerstone and MWI, now integrate with each other to provide a unique
inventory management solution that is virtually seamless. Using the IDEXX SmartOrder connection,
orders placed within Cornerstone receive real-time inventory status updates and pricing updates from
MWI. Order tracking is provided once MWI has processed an order and as orders are shipped. In
addition, Cornerstone automatically recognizes the receipt of the shipment.

Benefits of IDEXX SmartOrder include:

e Ordering from within your practice management system—The order process is within your work
flow so you do not have to switch among multiple systems to place or track an order.

¢ Real-time pricing details—When you place an order cost for that item is displayed in the purchase
order. In addition, when quantity discount opportunities are available, a notification is visible in the
SP (Special Pricing) column of the purchase order.

¢ Immediate notification of item availability—You will know right away if items are on back order.

¢ Item status updates—Orders can be tracked from the time they're placed to the time they arrive at
the practice.

e Automated electronic receipt of items—As ordered items arrive at the practice, receipts are
automatically populated with the appropriate information for quick and easy processing.

Note: Windows® Internet Explorer® 7 or later must be installed on each Cornerstone workstation. It does
not have to be the default Internet browser.

Setup

Setting Up Electronic Inventory Ordering with MWI Veterinary Supply
For IDEXX SmartOrder to seamlessly connect to the MWI online inventory ordering system, you must
complete a one-time setup to specify your account information and agree to the MWI terms of sale. This
will allow you to send and receive orders from MW!I without needing to log in to their website for each
online transaction.

Notes:

e You must have an account set up with mwivet.com to use IDEXX SmartOrder. If you do not have an
account set up, contact your MWI representative.

o New MWI customers must contact MWI to set up your account and activate online ordering with
mwivet.com. If you do not have an account set up, contact your MWI representative.

e Existing MWI customers can use their current MWI customer number to activate electronic
inventory ordering in Cornerstone, but you must also contact MWI to enable online ordering
through MWI.
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e There is a $99 annual service fee for IDEXX SmartOrder; however, this fee will be waived by MWI for
any practices that place annual orders totaling $5,000 or more directly through the IDEXX
SmartOrder inventory ordering system within Cornerstone. The annual tracking period will begin on
the date that you activate IDEXX SmartOrder within Cornerstone.

To use the service, you must:

e Have or establish an account with MWI at mwivet.com.
e  Set up electronic inventory ordering in Cornerstone and accept the MWI terms of agreement.
e Have a consistent, high-speed Internet connection.

To access Login/Password Management settings:
1. On the Lists menu, select Practice. The Practice List dialog box appears.

2. With your practice name selected, click Update (or double-click the practice). The Practice
Information window appears.

To set Login/Password Management account settings for MWI Veterinary Supply:
Only an administrator can set up and modify electronic inventory ordering with IDEXX SmartOrder.

1. On the Practice Information window, in the Login/Password Management area, select Vendor-MWI
Veterinary Supply from the drop-down list.

2. From the Associated Cornerstone Vendor drop-down list, select the practice-specific vendor
associated with MWI to use for this service.

3. Inthe Customer Number text box, enter your practice’s MWI customer number. You can find this
information on your mwivet.com account.

4. Select the Enable Online Ordering check box.

A pop-up box displays the terms and agreement. Review the terms and click Accept to activate the
service.

6. When you are notified that activation was successful, click OK.

7. Click Test to verify that you have a working Internet connection and valid login information for
accessing the vendor’s online ordering system.
In the Practice Information window, the user acceptance, date/time stamp, and a link to the MWI
terms and agreement is displayed when online ordering is enabled.
Note: You have now setup Cornerstone for online ordering. If you have not contacted
MWI E-Commerce Support to activate online ordering with MWI, you must do so before you can
begin placing orders. If you have not activated online ordering and place an order through
Cornerstone, it will not be processed and you will not receive your order.

Note: Multi-Location Single Database (MLSD) configuration only—The primary practice reviews and
agrees to the MWI terms of sale on behalf of all locations within the MLSD group. An administrator must
set up each secondary practice by following steps 1-4 above. Each secondary location can click the
Apply Primary Practice Settings button to use those settings or enter its own MWI customer number (if
applicable). The user acceptance, date/time stamp, and a link to the MWI terms of sale agreed to by the
primary practice are displayed for both primary and secondary practices when online ordering is
enabled.
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Disabling Electronic Inventory Ordering with MWI Veterinary Supply:
1. On the Lists menu, select Practice. The Practice List dialog box appears.

2. With your practice name selected, click Update (or double-click the practice). The Practice
Information dialog box appears.

3. On the Practice Information window, in the Login/Password Management area, select Vendor-MWI
Veterinary Supply from the drop-down list.

4. Clear the Enable Online Ordering check box.
Note: If you have open orders, a message indicating that you cannot disable online ordering until all
orders are closed appears.

5. If you have no open orders, click Yes when the message confirming your intent to disable online
ordering appears.

6. A message informing you that you have disabled online ordering in Cornerstone appears. To
complete your MWI unenroliment, you must contact MWI E-Commerce Support:

MWI E-Commerce Support
e Phone: 1-888-562-3405

e Email: ise-commerceteam@mwivet.com

Reactivating Electronic Inventory Ordering with MWI Veterinary Supply
If you have disabled your enroliment with MWI, you must first contact MWI E-Commerce Support (see
above) to establish or reactivate your account. Then, follow the setup instructions above to reactivate
online ordering within Cornerstone.

Use

Creating an MWI Purchase Order in Cornerstone

To create a purchase order for MWI:

1. Access the Create Purchase Order window from either the Purchase Order List or Purchasing Work

List window.
R
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On the Create Purchase Order window, select MWI Veterinary Supply or your practice-specific
associated vendor for MWI as the vendor.

In the invoice item grid, in the ID field, type the item ID and press TAB, or press F2 to search for and
select an item from the Search for Inventory ltem dialog box.

Once an item has been entered in the grid, Cornerstone performs a real-time check to verify the
following:

e [|tem has a matching MWI vendor item ID
e Ordered quantity is available

e [tem cost

e Any available quantity discounts

Note: An invoice item line marked “Back order” displays if the item is on back order with the
selected vendor. Contact MWI directly to check on expected date of availability.

A link for the MWI fulfillment and support terms of sale is displayed on the right side of the Purchase
Order List window. Click the link to review the order. You can also click the link to review MWI’s
terms and conditions.

Create a Purchase Order for a specific vendor

102

O Information for Lepto Titer at KSU

Save

Vendor* Group Place order
MW » All Groups ¥
Description ~ Oty UoM sP Cost Status Order by Notes  Sp Cancel
Lepto Titer at KSU 1.00 [Mone] |No $15.65 |Ordered Brady, Tom /

Press Tab to move from field to field.

Fulfillment and Support
“rour order will be sent to
mwivet.com for fulfilment
and is subject to all of MWI's.
Terms of Sale.

view MWI Terms of sale

Total Cost : $15.65 Remove From Order

5. Select Place Order.

Notes:

When you place an order through IDEXX SmartOrder, the order is sent to MWI for fulfillment. MWI is
fully responsible for fulfillment of your order, including providing customer support related to your
order.

If you have a credit card on file at MWI and are set up to be billed by credit card, you will be billed
when you place the order. You will not be able to pay by credit card when you receive the order.
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If you have questions regarding your order, contact MWI:
MWI Customer Support
Phone: 1-888-562-3405

Email: ise-commerceteam@mwivet.com
(email received after hours will be answered on the next business day)

Website: www.mwivet.com
Business hours: Monday-Friday, 8:00 a.m.—8:00 p.m.

Adding Vendor Item IDs for Matching Inventory Items in Cornerstone
When adding items to a purchase order, if an invoice item is not recognized by MWI or if the invoice item
does not have an associated MWI vendor item ID in Cornerstone, the invoice item line will display with a
yellow background and an alert message box appears.

At this point, you may either remove the item from the order or double-click the item’s description to
open the Suggested ltem List dialog box and select a suggested MWI item ID match for the item.

On the Suggested Item List dialog box, Cornerstone automatically populates the Description field with
the invoice item’s description in Cornerstone. Click Search to find any closely matching MWI item
descriptions. If you are unable to locate a matching item, you can refine search terms or change the
description to one or more words that may be recognizable and click Search again. If you select the
MWI item as a match, the MWI vendor item ID is automatically applied to the Cornerstone item. This item
will now be available for online ordering from Cornerstone in the future.

Note: If you make a mistake mapping your item ID to the MWI item ID, you will not be able to assign
that MWI vendor item ID. To remove the incorrect mapping, select Lists > Invoice Item and search for
the item. Click Update. On the Inventory tab, click ltem Vendor and delete the vendor item ID on the
grid.

Assigning Multiple Vendor Item IDs to a Single Inventory Item ID

You can set up multiple vendor item IDs for a single product as long as you use the same buy/sell ratio
for each vendor item ID.

For example, you might have more than one vendor for amoxicillin 50 mg capsules. With both vendors,
you buy in bottles of 50 capsules but sell individually. In this case, you could set up a vendor item ID for
each vendor and link both vendor item IDs to the same inventory item ID.

Buy Sell Example Example
Inventory ltem | Vendor ltem
ID ID
Vendor A Bottle of 50 Single tablet 1001 204
Vendor B Bottle of 50 Single tablet 1001 573

Adding a Vendor Item ID While Working with Inventory Orders
You can add a new invoice item when searching for an item on the Search for Inventory Item dialog box.
The enhanced Search for Inventory Iltem dialog box in Cornerstone 8.3 now includes new Vendor and
Vendor Item ID fields that provide a quick way to add the primary vendor/vendor item ID information for
the item.
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Search for Inventory ltem

Find an inventory item

Wendor ftem ID:

cancel |

Save

Reset
WVendor: | All'Vendors » Classification: | 41l Classifications ~
Description: ttem ID:
Search for a word Search vendor item IDe (only)
Include inactive inventory items
D &4 Wendor  WendortemID @ Description Classification Price Select
101 MW 1000 Metrenidazole injectable bag Injectablez £35.00 z
102 MW 10008 Lepto Titer at KSU Lab $43.50 E
ﬁ 103 MW 1004 Cerenia 24mg pack of 4 Pharmacy £16.00 =
104 MW 1000 Cerenia 80 mg pack of 4 Pharmacy 224.50
JE 107 MW 1 RCVD Canine Hepatic LS14 17 5Lbs Diet $38.65
43; 108 |HLLS Canine Z/D Ultra 27 SLbs Science Diet §75.12
1000 10% Dextrose Solution Injectables $0.00
H 112 MW 10N4R4 Wetmedin & ma Rnttle nf 50 Pharmar SRS NN ;
Search resutts 1 to 25 of 715 |‘ 4 > H Results per page {25 |w
- Add an tem |
ttem ID*: De=cription®:

Note: The alternative method for adding vendor and vendor item ID information for an item is as follows.
Select Lists > Invoice Item, and then click Update. On the Inventory tab, click ltem Vendor, and then
type the vendor and vendor item ID in the applicable fields in the grid (scroll horizontally to access the

Vendor item ID field).

I Invoice ltem Information for Cerenia 24mg pack of 4

10 Cerenia 24mg pack. of 4

(& Invertory () Gervice Group PFick. Dizpensing
| Vaccine ” Link Items " Spec. Actions " Travel ” ‘whiteboard |
| Info " Instiuctions " Feminders " Tar/Disc | Inventory

Inventory information

NDCADIN Code:| | Serial pwmber: ||

[ Maintain OH

[ Track expiration dates

Buw/zell ratio; 1 |

[v] =

‘ [Maone]

Bupbacade: [ ]

[ Track lot numbers

Itern Yendar

Stock at locations:

Reorder information by location

B

B

Central Storage | Select Ia' Item Yendor Information
Controlled Substances Item inf b
Flea and Tick Products i 1D: 103 Cerenia 24mg pack of 4
Food Products
Heartworm Prevention Yendor 1D MName I Primary | Lead time Cost Date |
Injectables Abwh Ml Veterina Supply | 0 16.00 03/28/2011 3 ﬂ
M L .oo UUJUUEUUUU&
o .00 004000000 f4]
»

Cancel
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Tracking Order Statuses from Cornerstone
New order tracking features for electronic inventory orders allow you to:

e See when the status of an ordered item changes, indicating if the order was sent, if the vendor
received the order successfully, etc.

e If the order is received successfully by MWI, the status is Sent — Online.

e If the order is not received by MWI, you will see a message asking you to complete the
order offline, and the status is Sent. If this happens, you need to use another method to
send the order, such as sending by the order by fax or calling MWI.

IR File Edit Activities Lists Controls Inventory Tools Reports Weblinks Window Help AEE
EEefdedAds 7ldHBoRNTATFLDERAR @ =6

View and manage purchase orders Add New Order
Vendor Status Date Range

Al Vendors v | [Anstatuses || [ 11062012 T To | 11202012 [ Search

PO Number & | Vendor Status Total Order by Date For group

123376 BISCO DENTAL FILM TRANS. Closed 50.00 Schuize, DV, Corrin 111812012

123377 I Closed 1282 Schulze, DVI, Corrin 11182012

123381 I Jsent— Onine b11.00 Schutze, DV, Corrin 117202012

123382 Heska Sent Ts0.00 Schuize, DV, Corrin 111202012

123383 WARKET LINK Sent 50.00 Schulze, DVM, Corrin 1172002012 u_”ma":’IJE[I Orders

123384 Novartis '1 a0 Schuize, DI, Corrin 111202012 imnehle)

123385 i TSent- Onine Ts2e8 Schuize, DVI, Corrin 117202012

123386 1w Sent- Oniine s10.49 Schutze, DV, Corrin 1112012012

123387 Novartis Sent 50.00 Schuize, DV, Corrin 111202012

123388 Thera Pet u.uu Schuize, DVI, Corrin 117202012

e Track individual invoice items in the order by clicking the Track link. This link launches the
associated website (USPS, UPS®, or FedEx®) to access tracking details. The link appears on the
purchase order once MWI has completed processing and shipped the item.

e  After submitting your order, you will receive a confirmation notice informing you that your order has
been placed with your practice’s associated vendor for MWI, along with a confirmation number for
use in the event you have to contact MWI.

Synchronization of Electronic Inventory Orders with MWI

If you are set up to use IDEXX SmartOrder with MWI online inventory ordering, Cornerstone checks MWI
online orders to detect unmatched orders.

Unmatched orders are orders that were placed with MWI without using Cornerstone—for example,
orders placed by phone or fax or by going directly to MWI.com. When an MWI order does not match a
purchase order in Cornerstone, the order does not appear in the table on the Purchase Order List
window. However, you can view these orders in the Unmatched Orders area on the right of the Purchase
Order List window, and use the following procedure to create matching purchase orders for them.

This synchronizes the electronic inventory orders from MWI with Cornerstone and adds them to the
Purchase Order List window.

If you start an order in Cornerstone but Cornerstone is not able to connect with MWI, a message
appears telling you that you need to complete the order offline. After you place this order (for example,
by phone or fax), Cornerstone detects it as an unmatched order. However, because a purchase was
already created before the Internet connectivity problem occurred, you need to follow a special
procedure to synchronize this kind of unmatched order. Otherwise, an extra, duplicate purchase

order will remain in Cornerstone. (See “To synchronize an order started in Cornerstone but

completed offline,” below.)
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To synchronize electronic inventory orders with MWI:

1. Select the view all link to open the Unmatched Purchase Orders window.
2. Select an order in the top grid to view the invoice items on that order in the bottom grid.

3. For any invoice item that does not have an associated Cornerstone inventory item ID, add the ID in
the appropriate field in the Inventory ltem column. All invoice items must have associated
Cornerstone inventory item IDs for the order to be reconciled and created.

Note: See “Adding Vendor Item IDs for Matching Inventory ltems in Cornerstone” on page 110 for
more information.

4. When each line item has been matched to an associated inventory item in Cornerstone, click Save
to create the purchase order in Cornerstone. The Unmatched Purchase Orders window closes, and
the purchase order appears on the Purchase Order List window.

To synchronize an order started in Cornerstone but completed offline:

1. Select the view all link to open the Unmatched Purchase Orders window.

Unmatched Purchase Orders E3

Unmatched Purchase Orders

Sales Order Number Vendor Status  Total Customer PO Number Date
7550776 uwl Sent $157579  |0848183653 0911122012
Delete
7556853 uw Sent 51254 0911172012

7562944 uw Sent $260.20 0932410474 09112012 Close

7597725 MWl Sent $1,402.98 1246841425 13112012

7625383 uwl Sent $846.47 1348195982 141122012
7653379 uwl Sent $46522 1555226 7413169 15112012

5636879 v Sent 517968 1836051412 18102012

Line items for Purchase Order: 5686879 All unmatched items must be matched bafore the PO can e completed
Invoice Number  Vendor kemD ™ Vendor kem Description Unit Cost Quantity inventory tem
6064128 20755 Biotene Water Addtive 407 510.23 3.00

6064128 32282 Ibuprofen Tabs £00mg B500 $13.05 1.00

6064128 33254 Novifit L 400mg B30 $43.20 200

6064128 35212 Ketoconazole Tab 200mg B100 $15.59 1.00

6084128 35784 Gabapentin Capsules £00mg B100 514,00 1.00

6064128 415 Depo Medrol 40mg Rx scc 519.95 1.00

2. If you know that the order listed is a duplicate, select it and click Delete to use the original purchase
order from the Purchase Order List.
Tip: The original purchase order has a lower purchase order number.
OR
If you decide to synchronize the unmatched order, follow the “To synchronize electronic inventory
orders with MWI” above.
Note: You must close the original purchase order in the Purchase Order List after you have
synchronized the new unmatched order.
To close an order:

a. Onthe Purchase Order List, select the purchase order that was originally created for this order.
b. Click Close Order. The status changes to Closed.
c. Click Delete. The original purchase order is removed from the Purchase Order List.

Receiving Orders

To receive an order:

1. Select Inventory > Order List. The Purchase Order List opens.
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2. Select the purchase order and click Receive Order.
3. Type the receipt number for your order in the Receipt Number box. The item list displays.

4. Review the order for completeness and update the status by either clicking Receive All or by
selecting Received from the Status drop-down list for each item.

5. Missing order information (e.g., lot number) is in red text. You must update this information before
you can post the order. Click Receipt Item Details to fill in the remaining fields.

6. Click Post.

7. Inthe Change Prices window, make any final adjustments and view the current and new pricing, if
applicable.

8. When finished making any changes, click Post.

W Purchase Order List [ENENE

View and manage purchase orders | Add New Order ‘
Vendor Status Date Range — ]
‘MWI Online ‘v | |AII Statuses ‘v | e = | search |$‘
- [ _eme ]

PO Number &  Vendor Status Total Order by Date | Delete ‘

123 M1 Online ‘Sent-Onine 58553 TODO nazTRnz | [ Gose Ovder_|

|

| Receive Order

I Receive Purchase Order

Select a vendor and enter a receipt number. tems on purchase order are displayed in the grid. To receive items change status to received. After

| Save |

changing the status make other adjustments needed. B

Open receipts for vendor | Save And Print |

Venao & lumber Date =New Receipt= 7|
[1w1 onine 0 B4 vammmoiz T |ISeeeE Post

15165454 — A

| Cancel |

PO Number

123 MWI Online 03-27-201; + Sort in original PO sequence To receive ftems froma

specific purchase order,

Status Qty 1) Description PO Number uom SP Cost Tax select the purchase order
= = " number. Click Receive Al
Received il 107 RCWD Canine Hepatic LS14 17 5Lbs. f 123 bag No $85.53 50.00; 1o change the status of all

items received or manually
change the status of each
item. To manually add the
item to the receipt, enter
item ID in the ID field. To
remove the items that you
have manually added to
the receipt, select the item
line and click Remove ftem.

‘Search rest

|Rece\pt Item Detals || Remove Item || Receivd All | ‘ Views Order Shipping: § 6.5 Total Tax: 5 0
Total $92.03

| O Information
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Login/Password Management

Cornerstone* 8.3 software includes new Login/Password Management features that allow you to set and
manage practice-wide settings for accessing a variety of features and services from the IDEXX

Cornerstone* Practice Management System.

These new settings are located on the Practice Information window (from the Lists menu, select

Practice, and then double-click a practice name).

™ Practice Information

Practice Information
Narme:| THE AMIMAL MEDICAL CEMTER

Address:| 2536 Alpine Road

City: E au Claire
State/Proy: Wl [v] Postal Code: 54703
Settings
Revenue Center:
Practice D1 Practice Color: E]

Login/Password Management

Account Information for
[ie]

Select the Email Service you prefer to uze

Communications - Email

(%) My Desktop email clisnt [Outlook, etc....]
() Comnerstone Imaging SMTP email settings

edit imaging SMTP zettings [ Controls > Defaults > Imaging > select ‘Email' tab |

Phones

Fhone
[715) 6BB-7777

Description Ext. |

Add

Clinic: [Primary]

Cancel

Note: If a Multi-Location Single Database configuration has been activated, the settings available may
differ based on whether you are updating settings for the primary practice or for a secondary practice.

Login/Password Management configuration is required for the following features and services.

e Email communications

e Fax communications using the IDEXX Faxing Service'

e Veterinary supply vendor—electronic inventory ordering?

e VetConnect PLUS

e Antech Reference Labs'

Note: Some of the above features and services (noted above with a ' dagger) require purchase of a

separate Cornerstone module or service.

New Database and Services Management Window
To support the new features in version 8.3, the Cornerstone software runs a number of new IDEXX
services in the background on your computer. To coordinate these services with each other and with
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your Cornerstone database, a new IDEXX Database and Services window appears when you start the
computer that is your Cornerstone server.

In many cases, this window and its subsidiary windows will appear automatically run a series of
operations, and close automatically. Once the operations are complete and you see the word
“Finished,” you can click Close (X) to close the window. If the window has already minimized to the
system tray, you can reopen it and click Close (X) to close it or you can just leave it minimized in the
system tray. You can launch Cornerstone once the operations are complete. If the IDEXX Database and
Services does not run automatically, use the instructions below.

If your practice uses a Terminal Services environment, you must launch the window each time you
launch your Cornerstone server by following the special instructions below.
To Manually Launch the IDEXX Database and Services Window:
1. Click Start in the lower left corner of your Windows® desktop, and select All Programs.
2. Scroll through the list of programs and select the Cornerstone folder to display its contents.
3. Click Cornerstone Database Server. The IDEXX Database and Services window appears.
4. Click Start.

A list of stopping and starting activities will appear in the window (as shown in the upper left
below). After a few moments, the Starting Cornerstone Database message will appear, along
with a second window (lower right).

Start Database and IDEXX Services Start: |
Stop Database and IDEXX Services Stop
Stopping =1l IDEAX Services and Programs (=]

Stopping IDEEK File Cleanup Serwvice
Stopping Idexx Logging Service
Stopping IDEXX Search Server
Stopping IDEEE Application Server
Stopping IDEXX Search Server
Stopping IDEEE Smart Service
Stopping IDEEE DICOM Services
Stopping Cornerstone Database

Starting Cornerstone Database

~#+ Sybase Adaptive Server Anywhere

Finizhed checkpoint of "train2" (rain2.db) at Tue Map 08 2012 09.51
Finizhed checkpoint of "train'' (train.db) at Tue bMay 08 2012 03:51
D atabasze "train" [train2.db) started at Tue May 08 2012 03:51
D atabaze "train" [train.db] started at Tue Map 03 2012 0951
Databaze "catone’’ [cstone db] started at Tue May 08 2012 0351
Transaction lag: CSASSIST LOG
Starting checkpoint of "ceaszsist” [ceaszsiet db) at Tue Map 03 2012 0951
Finizhed checkpoint of "czassist" [czassist db) at Tue May 08 2012 09:51
D atabasze "csassist” [caassist db) started at Tue May 08 2012 0251
D atabaze server started at Tue bay 08 2012 09:51
Trying to start Sharedtdemory link ...

SharedMemory link started successfully
Trving to start MamedFipes link ...

MamedPipes link started successfullp
Tryirg to start TCPIP link ..

2 Adaptive Server Anywhere

Shutdown |

The second window will close, and the IDEXX Database and Services window will display a
number of starting messages, followed by the word “Finished.”
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5. Click Close (X) in the upper right of the window to close it.

6. Start Cornerstone on any computer that is part of your network.

To launch the IDEXX Database and Services Window in a Terminal Services Environment

1. Double-click the Cornerstone Database m icon on your desktop. The IDEXX Database and
Services window appears.

2. Click Start.

A list of stopping and starting activities will appear in the window. After a few moments, the
Starting Cornerstone Database message will appear, along with a second window.

The second window will close, and the IDEXX Database and Services window will display a
number of starting messages, followed by the word “Finished.”

Click Close (X) in the upper right of the window to close it.

4. Start Cornerstone on any computer that is part of your network.

Additional Changes and Enhancements
Medical

Staff with appropriate security permissions can now make corrections to a vaccine tag (on the
Patient Clipboard, right-click the tag and select Correct).

When reissuing a vaccine tag, the old tag number is voided and remains viewable in Cornerstone for
reference purposes.

The first line of an enhanced medical note is not automatically included as part of its History
Description.

When a Pick List item is added to a medical note template, the Pick List item correctly displays when
the medical note is opened.

If invoice items included in a medical note template are reordered, the order is retained after saving
the template.

Including more than one Pick List item in a medical note no longer causes issues.
In enhanced medical notes, you can now paste the same piece of text into a note more than once.

When you use a document template that contains a pick list by default, duplicate documents are no
longer created and the pick list item is reflected on the Patient Visit List correctly.

When the Electronic Whiteboard window is minimized and then restored, it displays the current time
(no longer resets to midnight).

The Patient Treatments window updates more quickly when the main Whiteboard is open behind it.

When setting up a medical note or correspondence template, you can place text in a frame/text box
on the side of the page and the contents in the body of the document wrap around the box.

Entering/selecting a staff ID when entering vital signs for a patient no longer causes issues.
Entering vital signs for a patient belonging to an inactive client no longer causes an error.

For a quicker way to add attachments directly to enhanced medical notes or correspondence, from
the Patient Clipboard* or Patient File window, right-click the title of the document that you want to

Cornerstone 8.3 What’s New 118



Miscellaneous

attach additional information to and use the menu options to add or edit attachments. This feature is
available only for enhanced medical notes and correspondence in a state of Tentative or Draft.

Laboratory

Updated the IDEXX Reference Laboratories (U.S.) Directory of Services with 2012 pricing and new
testing features.

Introduced GREER® Aller-g-complete® allergy testing through IDEXX Reference Laboratories to test
and treat atopic canine, feline, and equine patients with serum allergy testing and immunotherapy.

Support for future release of IDEXX VetLab* Station 3.30 software update, which will introduce
additional testing options, including:
e |IDEXX ProCyte Dx* Hematology Analyzer can identify the presence of Band Neutrophils
(canine, feline, equine, and bovine) and nRBCs (canine and feline).

e Expanded species menu and support of body fluid analysis (abdominal and thoracic) for
both IDEXX ProCyte Dx and LaserCyte* hematology analyzers.

Reports

IDEXX Reference Laboratories Report PDF functionality has been restored.

The Inventory Audit Report correctly includes lot numbers for inventory items that are linked to
service items.

The Controlled Substance Report correctly includes all invoice item information when the report is
sorted by invoice item ID.

The Report Search window is no longer prevented from opening successfully under certain
circumstances.

Color and client address have been added to the patient history report.

A row showing patient and sales information has been added to the Statistics by Staff Report for the
end of all periods (day, month, and year).

The Invoice ltem Sales Information Report has been revised:
o The client name has been added. Staff is identified by ID.

0 The report can be filtered by revenue center.

You can select more than one image request at a time from all of the places where you can begin
the image capture process.

For any telemedicine cases existing in patient history, the history line on the Patient Clipboard
displays the word “RESULTS” when the telemedicine specialist report has been received. To view
the report, click the line to view the report in the Preview pane or double-click to open the report in a
separate viewing window.

As long as staff security is set appropriately, staff members set up with any role can delete individual
images. Previously, administrators could delete individual images but staff in other roles could
delete only complete image studies.

DICOM® images no longer appeared blank or inverted.

Reloading and retaking several shots in a large image study works correctly.
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Editing and saving images if image storage options are set in a certain way works correctly.

The crop feature has been adjusted so that it is accurate if you crop down to an area that is 50% of
the original image or smaller.

Clicking buttons on the Case Details window very quickly after the window appears works correctly.

Opening and submitting cases in practices with a large number of active staff members works
correctly.

The Enable TWAIN Ul check box on the Imaging configuration window has been restored. (Select
Controls > Defaults > Imaging and select Imaging on the left.) This check box is used to set up
some scanners and multifunction printers that use automatic document feeders.

Radiology log opens when you right-click the Patient Clipboard and select Imaging > Radiology
Log.

Images are sent more quickly using the Telemedicine tab on the Case Actions pane of the Case
Detail window.

Eliminated orange tint that appeared when older images were viewed with the IDEXX I-Vision
Mobile* application.

Importing DICOM files encoded in a certain way no longer causes Cornerstone to freeze.

General

Enhanced Appointment Schedule suite setup options allow you to display 12 or 16 columns on the
Schedule for Today window (in addition to the existing 4-, 6- and 8-column options). A widescreen
monitor is recommended for the 12- or 16-column setup.

The Daily Planner window's Call Backs tab correctly displays the complete client phone number
when a line is highlighted on this tab.

When performing a purge of client data, Cornerstone correctly purges the Referred By client ID data.

Added ability to export data for state of Washington Controlled Substance Export program. (Contact
IDEXX Cornerstone Support for instructions on using this functionality.)

When checking in an appointment from the Patient Clipboard with an associated secondary reason
for visit, the secondary reason for visit is reflected on the Patient Clipboard and the Census List.

Changed Cornerstone services behavior to avoid issues with ODBC connections and access to
shared folders.

Updated the Cornerstone Support phone number for Australia on the Help > About dialog box.

Made performance improvements to the Patient Clipboard to speed up display of the Vital Signs tab
and patient history.

Restored the ability to view detail of a payment by right-clicking the payment on the Client Account
Information tab of the Patient Clipboard and selecting View.

On newly created invoices, if you've chosen to calculate accounts receivable (A/R) by provider, and
to apply payment to specific invoices for A/R by provider, the payment is credited properly.

e To set this up, select Controls> Defaults> Practice and Workstation Defaults, and select
Invoice in the menu on the left. In the A/R by provider area, select the Calculate accounts
receivable by provider check box.
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e You can make invoice type mandatory for invoices. If an invoice type is not selected, the user will be
prompted to select one.

e To set this up, select Controls > Defaults > Practice and Workstation Defaults, and
select Invoice in the menu on the left. In the Invoice area, select the Invoice type required
check box.

¢ On the Invoice ltem Information window, in the Quantity/Amount/Markup table, fixed error that
occurred if you left one row blank (or with only zeroes entered) and then tried to enter information in
another row.

e  On monthly statements:

e As before, client invoice lines are grouped with corresponding payments and discounts.
Now, however, the information is shown with invoice first, then the discount, and then the
payment.

o Voided payments on accounts are now properly filtered out of monthly statements.
¢ On the Patient Orders window:

e When you transfer an item from the Patient Visit List to the Patient Orders window and that
item has several special actions of the same type, it no longer causes an error.

e The Patient Orders window no longer locks up when it is open on more than one
workstation at the same time.

o No matter where you access a prescription from, a warning appears on the prescription for items
that are set as controlled substances.

e If you have an invoice set up with a vaccine tag special action, you are required to enter a vaccine
tag number before you post an invoice containing that special action.

e An error that occurred if you entered incorrect patient weight information, voided it, and then entered
the correct weight no longer occurs.

e Patient birthdates in the future are no longer allowed.
e The Cook County Extract now includes results from the full date range.
e You can now use an email address to search for a client on the Client List dialog box.

e You can apply a discount to all the lines in an invoice. On the Transitions Discounts dialog box,
select the Add line discounts to all lines for this patient check box. Note that proper security
settings must be enabled to use this feature.

e For Multi-location/Single Database (MLSD) only, the Client tab of the Client/Patient Report Builder
includes an option to filter clients based on home practice.
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